NOTICE

This document contains information about one or more ABB products and may include a description of or a reference to one or more standards that may be generally relevant to the ABB products. The presence of any such description of a standard or reference to a standard is not a representation that all of the ABB products referenced in this document support all of the features of the described or referenced standard. In order to determine the specific features supported by a particular ABB product, the reader should consult the product specifications for the particular ABB product.

ABB may have one or more patents or pending patent applications protecting the intellectual property in the ABB products described in this document.

The information in this document is subject to change without notice and should not be construed as a commitment by ABB. ABB assumes no responsibility for any errors that may appear in this document.

Products described or referenced in this document are designed to be connected, and to communicate information and data via a secure network. It is the sole responsibility of the system/product owner to provide and continuously ensure a secure connection between the product and the system network and/or any other networks that may be connected.

The system/product owners must establish and maintain appropriate measures, including, but not limited to, the installation of firewalls, application of authentication measures, encryption of data, installation of antivirus programs, and so on, to protect the system, its products and networks, against security breaches, unauthorized access, interference, intrusion, leakage, and/or theft of data or information.

ABB verifies the function of released products and updates. However system/product owners are ultimately responsible to ensure that any system update (including but not limited to code changes, configuration file changes, third-party software updates or patches, hardware change out, and so on) is compatible with the security measures implemented. The system/product owners must verify that the system and associated products function as expected in the environment they are deployed.

In no event shall ABB be liable for direct, indirect, special, incidental or consequential damages of any nature or kind arising from the use of this document, nor shall ABB be liable for incidental or consequential damages arising from use of any software or hardware described in this document.

This document and parts thereof must not be reproduced or copied without written permission from ABB, and the contents thereof must not be imparted to a third party nor used for any unauthorized purpose.

The software or hardware described in this document is furnished under a license and may be used, copied, or disclosed only in accordance with the terms of such license. This product meets the requirements specified in EMC Directive 2004/108/EC and in Low Voltage Directive 2006/95/EC.

TRADEMARKS

All rights to copyrights, registered trademarks, and trademarks reside with their respective owners.

Copyright © 2003-2015 by ABB.
All rights reserved.

Release: October 2015
Document number: 3BUF001091-600 A
Table of Contents

About This User Manual
Document Conventions ...................................................................................................11
Warning, Caution, Information, and Tip Icons .................................................................12
Terminology .....................................................................................................................12
Released Documentation .................................................................................................13

Section 1 - Introduction
Information Locations .....................................................................................................15
Section Overviews ..........................................................................................................17

Section 2 - Configuring Basic Functionality
Verifying Installation of Information Management ........................................................20
Log-In User Authority .....................................................................................................21
Building a Process Simulation ......................................................................................21
Configuring SoftPoints ..................................................................................................22
  Set-up Requirements for SoftPoints ......................................................................22
    Open the Workplace ..........................................................................................23
    Configuring SoftPoint Services ....................................................................23
    Integrating SoftPoint Alarms and System Messages ................................26
Adding a New SoftPoint Object Type .........................................................................27
Configuring the SoftPoint Object Type .......................................................................28
Adding a Signal .............................................................................................................29
Configuring Signal Properties ....................................................................................30
Configuring Alarm Trip Points ....................................................................................31
Adding a Signal to Support the Calculation Logic .....................................................35
Applying the Calculation ...............................................................................................36
### Table of Contents

- Specify that the Calculation be Copied to Instantiated SoftPoints .................41
- Instantiating and Deploying SoftPoints..........................................................42
- Deploying a SoftPoint Configuration ...............................................................47
- Enabling the Calculations ..............................................................................48
- Collecting and Viewing Historical Data..........................................................50
- Configuring Node Assignment for Trend Logs ..............................................51
- Creating a Log Template..................................................................................54
  - Adding a Direct Trend Log...........................................................................56
  - Adding a Hierarchical History Log ...............................................................59
  - Configuring an Information Management Log............................................61
- Adding a Log Configuration Aspect to an Object ...........................................63
  - Using the Plant Explorer.............................................................................63
  - Using the Bulk Configuration Tool...............................................................70
- Viewing Historical Data using DataDirect System 800xA Toolbar ..................79
- Alarm/Event Data ..........................................................................................83
  - Viewing Alarms and Events.......................................................................84
  - Adding an Event List to the Object Type.....................................................84

### Section 3 - Report and Scheduling for Operations

- Creating a History Report using DataDirect System 800xA Toolbar ...............88
- Creating a Process Value Report using DataDirect System 800xA Toolbar ......91
- Creating an Alarm and Event Report using DataDirect System 800xA Toolbar .92
- DataDirect Report Templates for Scheduler ..................................................94
- Adding Report Parameters for User-defined Template ....................................94
- Attaching Report Templates to File Viewer Aspects .......................................96
- Scheduling a Report .......................................................................................97

### Section 4 - Reports and Scheduling

- Use of Log Template.......................................................................................106
- Creating a User-defined Report Template using DataDirect System 800xA ......106
- Adding Parameters to User-defined Report Templates using
  DataDirect System 800xA .............................................................................111
- Creating a Simple History Report using ODBC and ODA...............................112
Adding Parameters to the History Report.................................................................117
Creating a Real-Time Report with Excel.................................................................123
Creating a History Report with Crystal Reports......................................................130
Attaching Report Templates to File Viewer Aspects.................................................132
Scheduling a Report .................................................................................................133
Historizing a Report .................................................................................................139
Alternative Tag Query ..............................................................................................140
Create Workbook (Spreadsheet)............................................................................141
Configure Bulk Import Filter .............................................................................141
Fill Workbook ........................................................................................................142
Customize Report (Sheet) .......................................................................................142

**Section 5 - Configuring Additional Functionality**

Configuring a Message Log ......................................................................................143
  Message Log Configuration Procedure...............................................................144
  Specify Message Log Operating Parameters .....................................................145
Reading the Message Log .......................................................................................146
  Verifying the Data Provider Connection .............................................................146
  Starting DataDirect ...............................................................................................147
  Enabling the Menu/Tool Bar Options for the Message Log Dialog using DataDirect Inform IT.....147
  Retrieving Messages using DataDirect Inform IT Toolbar ..............................148
Configuring Historical Data Archiving ...................................................................150
  Adding an Archive Device .................................................................................151
  Activate the Archive Device ............................................................................154
  Adding the Archive Group Object ....................................................................155
  Adding Archive Groups ....................................................................................155
  Adding Entries to Archive Groups .................................................................157
  Setting Up the Archive Schedule for an Archive Group ..................................158
  Adding a Job and Specifying the Schedule .......................................................159
  Adding and Configuring the Archive Action ....................................................161
  Performing a Manual Archive .........................................................................163
  Accessing Archive Data .....................................................................................163
### Table of Contents

- Publishing an Archive Volume ................................................................. 164
- Accessing Published Logs ........................................................................ 165
- Viewing Published Archive Data with DataDirect ....................................... 169
- Unpublishing a Volume ............................................................................. 170
- Inform IT Authentication ............................................................................. 170
- Configuring Access Control ....................................................................... 171
- Checking Access Control .......................................................................... 171

### Section 6 - Batch Integration

- PDL for Batch Management Overview.......................................................... 174
- Configure Information Management for Batch ........................................... 175
  - Add Batch Specific Message Log .............................................................. 175
  - Set Up the Batch Report Job ................................................................. 175
  - Set Up Batch Archive ........................................................................... 176
- Configure Batch for Information Management ........................................... 177
  - Adding Equipment and Variables ............................................................ 177
- Adding Recipe Procedure ........................................................................... 178
  - Create and Connect Acquire Unit (Acquire Equipment) ....................... 180
  - Create and Connect Start History (Batch Data Collection) ................... 181
  - Create and Connect Restart Time (Compute) ........................................ 181
  - Create and Connect Delay (Transition) .................................................. 182
  - Create and Connect Release Unit (Release Equipment) ....................... 182
  - Create and Connect Batch Report (Schedule Job) ............................... 182
  - Create and Connect End Time (Compute Block) .................................... 183
- Run the Batch From the Batch Overview .................................................. 183
- Verify Output using PDL Browser .............................................................. 184
- Viewing the Executed Batch Report ........................................................... 184
- Additional Lessons .................................................................................... 185
  - Views for Batch Management ................................................................. 185
  - Creating Reports using Typical Queries and Views .................................. 185
  - Batch Archiving ..................................................................................... 186
  - Verify that Batch Archive Completed .................................................... 186
  - Manual Archiving .................................................................................. 186
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Looping Recipe Limitations</td>
<td>187</td>
</tr>
<tr>
<td>User Message Formats</td>
<td>188</td>
</tr>
<tr>
<td><strong>Revision History</strong></td>
<td></td>
</tr>
<tr>
<td>Introduction</td>
<td>191</td>
</tr>
<tr>
<td>Revision History</td>
<td>191</td>
</tr>
<tr>
<td>Updates in Revision Index A</td>
<td>191</td>
</tr>
<tr>
<td><strong>Index</strong></td>
<td></td>
</tr>
</tbody>
</table>
About This User Manual

Any security measures described in this User Manual, for example, for user access, password security, network security, firewalls, virus protection, etc., represent possible steps that a user of an 800xA System may want to consider based on a risk assessment for a particular application and installation. This risk assessment, as well as the proper implementation, configuration, installation, operation, administration, and maintenance of all relevant security related equipment, software, and procedures, are the responsibility of the user of the 800xA System.

This user manual provides basic instructions for configuring Information Management functionality for the 800xA System. This includes:

• Configuring basic functionality using softpoints and calculations to build a process simulation and History Services to collect numeric process data.
• Using reports and scheduling to view the simulation data.
• Additional functionality such as archiving.

This instruction is intended for application engineers who are responsible for configuring and maintaining these applications. This instruction is not the sole source of instruction for this functionality. It is recommended that you attend the applicable training courses offered by ABB.

Document Conventions

Microsoft Windows conventions are normally used for the standard presentation of material when entering text, key sequences, prompts, messages, menu items, screen elements, etc.
Warning, Caution, Information, and Tip Icons

This User Manual includes Warning, Caution, and Information where appropriate to point out safety related or other important information. It also includes Tip to point out useful hints to the reader. The corresponding symbols should be interpreted as follows:

- Electrical warning icon indicates the presence of a hazard that could result in *electrical shock*.

- Warning icon indicates the presence of a hazard that could result in *personal injury*.

- Caution icon indicates important information or warning related to the concept discussed in the text. It might indicate the presence of a hazard that could result in *corruption of software or damage to equipment/property*.

- Information icon alerts the reader to pertinent facts and conditions.

- Tip icon indicates advice on, for example, how to design your project or how to use a certain function.

Although Warning hazards are related to personal injury, and Caution hazards are associated with equipment or property damage, it should be understood that operation of damaged equipment could, under certain operational conditions, result in degraded process performance leading to personal injury or death. Therefore, fully comply with all Warning and Caution notices.

Terminology

A complete and comprehensive list of terms is included in *System 800xA System Guide Functional Description (3BSE038018*)*. The listing includes terms and definitions that apply to the 800xA System where the usage is different from commonly accepted industry standard definitions and definitions given in standard dictionaries such as Webster’s Dictionary of Computer Terms. Terms that uniquely apply to this User Manual are listed in the following table.
Released Documentation

A complete list of all documents applicable to the 800xA System is provided in *System 800xA Released User Documents (3BUA000263*)*. This document lists applicable Release Notes and User Instructions. It is provided in PDF format and is included on the Release Notes/Documentation media provided with your system. Released User Documents are updated with each release and a new file is provided that contains all user documents applicable for that release with their applicable document number. Whenever a reference to a specific instruction is made, the instruction number is included in the reference.
Section 1  Introduction

This instruction provides a series of tutorials that show you how to go from staring blankly at your installed Information Management software to building and using real-world Information Management applications. This instruction does not cover every application in complete detail. This is left for the standard documentation which is readily available on CD and online via the ABB Library or SolutionsBank.

Information Locations

Table 1 lists the instructions and the specific information they contain concerning Information Management.

Table 1. Information Management Documentation

<table>
<thead>
<tr>
<th>Document Number</th>
<th>Document Title</th>
<th>Topics</th>
</tr>
</thead>
<tbody>
<tr>
<td>3BSE034678*</td>
<td>System 800xA Manual Installation</td>
<td>Basic system and Information Management installation</td>
</tr>
<tr>
<td>3BSE041389*</td>
<td>System 800xA System Planning</td>
<td>Information Management planning and considerations</td>
</tr>
<tr>
<td>3BUA000156*</td>
<td>System 800xA Post Installation</td>
<td>Post installation steps for configuring the Information Management server</td>
</tr>
<tr>
<td>Document Number</td>
<td>Document Title</td>
<td>Topics</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------</td>
<td>--------</td>
</tr>
<tr>
<td>3BUF001091*</td>
<td>System 800xA Information Management Getting Started</td>
<td>Configuration tutorial covering: Numeric logs, SoftPoints, Calculations, Reporting, Archiving, Batch Management</td>
</tr>
<tr>
<td>3BUF001092*</td>
<td>System 800xA Information Management Configuration</td>
<td>Configuring SoftPoints, Configuring calculations, Configuring the history database, Configuring production data and message logs, Configuring archiving, Configuring ODBC connectivity, History database maintenance (Backup and restore)</td>
</tr>
<tr>
<td>3BUF001093*</td>
<td>System 800xA Information Management Configuration for Display Services</td>
<td>AdvaInform display servers, Display creation, Display operation, Scripting language</td>
</tr>
<tr>
<td>3BUF001094*</td>
<td>System 800xA Information Management Data Access and Reports</td>
<td>Inform IT Excel Data Access (DataDirect), System 800xA Excel Data Access (DataDirect), Desktop trends, Report scheduling, General scheduling, User tag management utility, Reading and managing archives, Message logs and tables, Production data log tables, Numeric tables, ODBC connectivity</td>
</tr>
</tbody>
</table>
Section Overviews

Section 2, Configuring Basic Functionality describes how to:

- **Verify your system installation.** This lesson gives a quick run-down of installation and set-up requirements that are sometimes overlooked and must be in place before beginning to use Information Management software.

- **Build a process simulation.** This lesson describes how to simulate a live process with SoftPoint and Calculation Services. The purpose of this exercise is to provide moving data points to serve as data sources for historical data collection. Similar data sources could be constructed in Control Builder M.

- **Collect and view historical data.** This lesson describes how to use History Services to collect numeric process data, and then view this information using various desktop data access tools including DataDirect (Excel Data Access).

Section 4, Reports and Scheduling provides a series of tutorials that describe how to use:

- DataDirect reports ([Creating a User-defined Report Template using DataDirect System 800xA on page 106](#)).

- History reports using Excel ([Creating a Simple History Report using ODBC and ODA on page 112](#)).

- Report parameters ([Adding Parameters to the History Report on page 117](#)).

- Real-time reports using Excel ([Creating a Real-Time Report with Excel on page 123](#)).

- Crystal reports ([Creating a History Report with Crystal Reports on page 130](#)).

- File Viewer aspects ([Attaching Report Templates to File Viewer Aspects on page 132](#)).

- Scheduling reports ([Scheduling a Report on page 133](#)).

- Historizing reports ([Historizing a Report on page 139](#)).

Section 5, Configuring Additional Functionality provides a series of tutorials that describe how to:

- Configure an Information Management message log for extending online storage and offline archival.
• Configure archiving for process (numeric) and alarm/event data.
• Publish an archive volume and read archived data.
• Configure authentication to help meet FDA 21CFR part 11 requirements.

Section 6, Batch Integration describes how to:

• Populate the Production Data Log for a batch recipe and create logs as a result of using batch start/end, phase start/end, and so forth. This includes the use of:
  – Task Variables
  – History Association
  – Message Log and PDL Log association

• Pass parameters from the Batch Recipe to the Schedule argument structure and into the report.

• Create reports using typical queries and views.

• Define batch archiving and aging of the online data.

These activities are designed to follow the flow of information from Batch Management into the Information Manager, out to reports and finally the safe off line storage of the Batch Production Data in an archive.
Section 2  Configuring Basic Functionality

Upon completion of this tutorial you will be able to use SoftPoint and Calculation Services to simulate a live process, configure History Services to collect process and alarm/event data from the SoftPoints, and view the data using Information Management desktop tools. Mostly, base 800xA System functionality is used in this part of the tutorial. Any extended Information Management functionality is identified to show the benefits of using extended methods.

To meet these objectives you will:

- Use the Information Management Configuration Assistant to ensure that you have:
  - met the minimum system requirements.
  - installed all required software.
  - performed all required post-installation procedures.

- Use the SoftPoint and Calculation Services to build a process simulator that produces moving data points. These data points will serve as data sources for historical logs configured in History Services.

- View historical data using DataDirect.
The system architecture for this tutorial is illustrated in Figure 1.

Verifying Installation of Information Management

Use the Information Management Configuration Assistant to ensure you have completed all procedures required to install and set up an Information Management server (if used). If you find that any of these requirements have not been met, then return to the installation and post installation activities for an Information Management server.

To launch the assistant, from the Windows task bar, choose:

**ABB Start Menu > ABB Industrial IT 800xA > Information Mgmt > IM Configuration Assistant**

Check the Status column for both Prerequisite Software and Information Management Configuration (Figure 2). All statuses should be Complete.
Log-In User Authority

This tutorial requires creating object types in the Aspect Directory. To do this, log in as a user belonging to the IndustrialITAdmin user group.

Use the SAME user that installed the Information Management software. New users are required to add DataDirect and Bulk Import add-ins to Microsoft Excel. These procedures are covered in the operation and configuration books for Information Management.

Building a Process Simulation

The purpose of this exercise is to provide moving data points to serve as the data sources for historical data collection.

SoftPoint Services is used to configure and use internal process variables not connected to an external physical process signal. Once configured, the SoftPoints
may be accessed by other 800xA system applications as if they were actual process points.

Each SoftPoint object will have:

- An integer signal driven by a calculation that counts from 0 to 100 and back to 0.
- Historical data for each signal collected by a property log configured in History Services.
- A second integer signal used to support the calculation logic.
- High and low limits will be configured for the signals so that alarms will be generated. These alarms will be collected by the system message services and may be viewed via alarm and event list aspects for the SoftPoint signal objects.

As an option, a message log may be configured in History Services for extended online storage and offline archival of alarm/event data. This is described in another lesson in Section 5, Configuring Additional Functionality.

---

### Configuring SoftPoints

SoftPoint objects are instantiated from SoftPoint object types configured in the Object Type Structure. The object types are templates from which the actual SoftPoint objects are instantiated.

### Set-up Requirements for SoftPoints

SoftPoints are instantiated in the Control Structure under a SoftPoint Generic Control Network object. This object establishes the connection with a specific SoftPoint server. Configuration of the SoftPoint Generic Control Network and related objects is completed as a post installation procedure and should already be done (refer *System800xA 6.0 Post Installation (2PAA111693*)). This will automatically configure the following:

- SoftPoint service group object and service provider object(s).
- Virtual control network by which other system applications (History, desktop applications and so on) can access the SoftPoint data on that node.
Section 2 Configuring Basic Functionality

Set-up Requirements for SoftPoints

- Source Definition aspect for each network. This is used to deploy the SoftPoints on their respective nodes.
- Integrates the SoftPoint alarm and event messages into the 800xA system message service.

Before beginning this tutorial, confirm that this configuration has been completed. If this setup is complete, skip to Adding a New SoftPoint Object Type on page 27.

Open the Workplace

Use the Plant Explorer workplace to access the Structure Selector.

1. From the Windows task bar choose: 
   ABB Start Menu > ABB Industrial IT 800xA > System > Workplace.

2. Select Plant Explorer Workplace, and click Open. The initial view of the Plant Explorer Workplace shows the 800xA system objects and aspects within their structural organization.

3. Use the Structure drop-down list in the upper left part of the Plant Explorer (Figure 3), to select the Control Structure.

![Select Control Structure from this pull-down list.](Image)

Figure 3. Plant Explorer Initial View - Selecting Control Structure

Configuring SoftPoint Services

1. In the Control Structure, select the Root, Domain and choose New Object from the context menu. This displays the New Object dialog.

2. Expand the Object Types category, and select SoftPoint Generic Control Network (under SoftPoint Basic Object Types). Enter a name to identify the network (for example: SoftPoint), then click Create.
3. Select the **Generic Control Network Configuration** aspect of the new object and click on the **Configure** tab as shown in Figure 4.

![Figure 4. Generic Control Network Configuration Aspect](image)

4. Click the Server Settings **Configure** button (Figure 4).

5. Select the primary Connectivity Server Node where SoftPoints is installed (Figure 5), and click **OK**.
Section 2  Configuring Basic Functionality  

Set-up Requirements for SoftPoints 

6. Click **OK** at the configuration completed message. The configuration of the server settings for a non-redundant SoftPoint network is complete (Figure 6). 

7. Click the Server Settings **Configure** button again if redundant connectivity servers were created.
8. Check the box **Node is redundant provider** and then select the redundant Connectivity Server Node where SoftPoints is installed (Figure 7) and click OK.

![Figure 7. Choose Connectivity Server Node (Redundant)](image)

9. Click **OK** at the configuration completed message. The configuration of the server settings for a redundant SoftPoint network is complete.

**Integrating SoftPoint Alarms and System Messages**

In order for the system message service to collect alarms and events from the SoftPoints on this network, the ABB 800xA Soft Alarms OPC Server must be added to an Event Collector, Service.

This is done automatically when the Alarm and Event Settings part of the **Generic Control Network Configuration** aspect is configured:

1. Click the Alarm and Event Settings **Configure** button (Figure 6).
2. Add providers in the same way was done for the Server Settings.
Adding a New SoftPoint Object Type

Create an object type template. This template will be used to instantiate SoftPoint objects into the Control Structure under the SoftPoint Generic Control Network object.

1. Open the **Object Type Structure** using the Structure selector.
2. Select **SoftPoint Object Types** and choose **New Object** from the context menu as shown in Figure 8.

![Figure 8. Creating a New SoftPoint Object Type](image-url)
3. In the New Object dialog (Figure 9) select **SoftPoint Process Object Type**, assign a name to the new object (**Counter** in this example), then click **Create**.

![Figure 9. New Object Dialog, Counter](image)

**Configuring the SoftPoint Object Type**

Add an integer signal type via the Process Object Configuration aspect (Figure 10):

1. Select the new SoftPoint object type in the Object browser (left hand pane).
2. Then click on the **Process Object Configuration** aspect in the object’s aspect list (right hand pane).
Adding a Signal

The Add Signal buttons are located in the upper left part of the SoftPoint Process Object Configuration aspect as shown in Figure 11.

To add the integer signal type,

1. Click the Integer signal button.
2. Enter a meaningful name in the New Signal Type dialog, for example Count (Figure 12).
3. Click **OK**.

![Figure 12. New Signal Type Dialog, Count](image)

**Configuring Signal Properties**

Signal properties that may be configured include range (high/low limits), engineering units label, and whether or not the signal should be controllable.

To configure signal properties:

1. With the new signal type selected, click the **Signal Configuration** aspect (Figure 13).

![Figure 13. Displaying the SoftPoint Signal Configuration Aspect](image)

2. The signal must be made controllable to let the calculation drive the signal value. To make a signal controllable, click the **Controllable** tab, and then click the **Is Controllable** check box (Figure 14), and then click **Apply**.
For this tutorial, DO NOT check the Log operator actions check box. This would cause every signal value change to be logged as an event (calculation updates to SoftPoints are treated as operator actions).

![Figure 14. Making the Signal Controllable](image1)

3. To set limits for signal, click the Range tab, key in the required limits, and click Apply. In the example shown in Figure 15, the Low limit is 0 and the High limit is 100.

![Figure 15. Setting the High and Low Limits](image2)

**Configuring Alarm Trip Points**

SoftPoint limiters are trip points in the signal’s overall range that, when crossed, generate an alarm and/or an event. These will be recorded in the system message.
services. Up to eight limiters can be specified for a signal. To do this (reference Figure 16):

1. With the signal type selected in the left pane, select the **Alarm Event Configuration** aspect.

2. On the **Limiter** tab, select **1 Limiter1** and enable the Use Limiter option. This activates the limiter configuration fields.

![Figure 16. SoftPoint Limiters Configuration Aspect](image)

Reference Figure 17 for Step 3 through Step 6.
3. The name defaults to Limiternumber. Rename the limiter to make it more easily identifiable, for example: CountHigh.

4. Specify the **Type** to indicate whether the limiter will trigger an event when the signal rises above a maximum value (**Max**), or drops below a minimum value (**Min**).

5. Enter a **Limit**. This is the threshold that the signal must cross to trip an alarm (drop below if type is Min, or exceed if type is Max).

   The **Hysteresis** may be set to filter spurious alarms caused by signals that fluctuate around the limit. This is optional and is not covered here.

6. Click **Apply**.

7. Repeat **Step 2** through **Step 6** to configure up to four limiters. An example of a completed limiter list is shown in **Figure 18**.

**Summary:**

- CountHigh, Max, 95
- CountMidHigh, Max, 90
- CountMidLow, Min, 10
- CountLow, Min, 5
The limiter can be deactivated by selecting the limiter and unchecking the **Use limiter** option.

8. To enable the alarms for this signal:
   a. Check the **Is an event** option on the **Event** tab.
   b. Select a limiter signal and check **Is an alarm** (Figure 19) on the **Alarm** tab. Repeat this for each limiter. Then click **Apply**.
Adding a Signal to Support the Calculation Logic

The calculation logic that drives the Count signal value requires an integer variable whose value is set to 1 or -1, depending on whether the signal value is being increased or decreased. This is implemented by adding an integer signal to the SoftPoint object, and then writing the integer value (1 or -1) from the calculation.

1. Select the Counter, SoftPoint Process Object Type as shown in Figure 10.
2. Select the Process Object Configuration aspect.
3. Use the Add Integer Signal button (Figure 11).

Figure 19. Enabling Alarms for this Signal
4. Give this signal the name `upDown` as shown in Figure 20.

![New Signal Type Dialog, UpDown](image)

Figure 20. New Signal Type Dialog, UpDown

5. Configure signal properties to make the signal controllable as demonstrated in Figure 14 and Figure 15.

### Applying the Calculation

Add a Calculation aspect to the SoftPoint object type to drive the SoftPoint’s Count signal value and thus simulate a live process. By adding the aspect to the object type, the Calculation may be applied to each object instance that is created from the object type. To begin (reference Figure 21):

1. Select the Counter object type and choose New Aspect from the context menu.
2. In the New Aspect dialog select the Calculation aspect.
3. Enter a meaningful name, for example: `CountUpDown`, then click Create.
4. Click on the Calculation aspect to display its configuration view (Figure 22).

5. Use the variable grid (top part of aspect view) to map calculation variables to their respective OPC data points (in this case the Count and upDown SoftPoint...
signals are mapped to the Value property), Figure 23. Both are declared as Output variables so the calculation will update the signal values each time the calculation executes.

![Figure 23. Mapping Variables](image)

Figure 23. Mapping Variables

- Use the Insert Line button on the tool bar to add a line in the variable grid (Figure 24). Two variables are required: **OutputVar** and **upDown**.

![Figure 24. Insert Line Button](image)

Figure 24. Insert Line Button

Complete the mapping as shown in Figure 23 and as described below.

- Declare an output Variable named **OutputVar** and **upDown** as shown in Figure 23. Use the Object and Property columns to specify the signal’s Value property as a data point to be updated by the calculation.

- Specify the Object as a relative object reference (./). Relative referencing allows the same calculation to be used for multiple object instances without having to change object references. Check case sensitivity to ensure the correct object is referenced.

- Select the Property from the pull-down list. The contents of this list is based on the object specified.

- Select the Direction as **Output** from the pull-down list. Output values are written to the property AFTER the calculation has executed. Output values are also available for use in the script as it executes.
f. Set the State to **Online** for both signals.

g. Enter an initial Offline Value of 1 for *OutputVar* and -1 for *upDown*.

6. Enter the calculation script as shown in **Figure 25**. This script ramps the Count value up to 100 and then back to 0.

   ```plaintext
   Option Explicit
   If OutputVar >= 100 Then
       upDown = -1
    ElseIf OutputVar <= 0 Then
       upDown = 1
    End If
    OutputVar = OutputVar + CInt(upDown)
    OutputVar.quality = 192
    Settings.UpdateStatus = False
   
   Figure 25. Calculation Script
   ```

7. Click the Editor/Scheduler toggle button on the toolbar to change the view to Scheduler. This is used to specify either a cyclic schedule, or a time-based schedule. For this tutorial, specify a cyclic schedule (**Figure 26**).

   ![Editor/Scheduler Button](image)

   **Figure 26. Change to Scheduler Button**

8. Check the **Cycle** check box. In the corresponding fields specify the interval unit (hours, minutes, seconds), and the number of intervals. The example in **Figure 27** shows a 2-second cycle. This will cause the calculation to execute, and the Count signal value to change, every two seconds.
9. Save the calculation configuration by clicking the Save button on the tool bar (Figure 28).

The Calculation Editor View does not prompt the user when exiting and changes are pending. Use Save button before leaving the display.

Check whether or not the calculation is working by manually executing the calculation off line. To do this, click the test off line button a few times (Figure 29). If the calculation is working, the Offline Value for the OutputVar variable will be incremented or decremented by one each time the button is clicked.
Specify that the Calculation be Copied to Instantiated SoftPoints

Even though the calculation aspect was added to an object type, the calculation will not be copied into the instantiated objects created from the object type unless this functionality is specified. To do this (reference Figure 30):

1. Go to the **Counter Type Definition** aspect for the SoftPoint object type.
2. Click the **Aspect Control** tab.
3. Select the Calculation category, in this case: **CountUpDown**.
4. Check the box labeled **Copy to all instances**.
5. Click **Apply**.
The calculations must be enabled once they have been instantiated in the Control Structure. How to instantiate the SoftPoints and then enable the calculations is covered in the following sections.

**Instantiating and Deploying SoftPoints**

SoftPoint objects are instantiated in the Control Structure. The objects can be created one-object-at-a-time or a bulk instantiation of a specified number of objects of the same object type can be performed. This section demonstrates the bulk instantiation method. To do this (reference Figure 31):
Figure 31. Selecting the SoftPoint Process Objects Group

1. Go to the Control Structure using the Structure selector.

2. Select the SoftPoint Generic Control Network object in the Control Structure, and click the Generic Control Network Configuration aspect.

3. Click the Create New Object button in the top left corner of this aspect view. This displays the Create New Object dialog (Figure 32).

4. Select the Counter SoftPoint object type from which to instantiate the new SoftPoint objects as shown in Figure 32.
5. Create 10 new objects with a starting number of 1 and enter the object name, in this case counter.

6. Click OK. The result is shown in Figure 33. A unique name is created for each new object consisting of the basic name plus a sequential numeric suffix starting with the specified Starting number.
7. After creating new objects in the Control Structure, rename all the **Count** and **upDown** SoftPoint Signal types with the parent object name as the prefix. For example, rename **Count** and **upDown** SoftPoint Signal type under **Counter1** SoftPoint object type, as **Counter1 Count** and **Counter1 upDown** respectively. Repeat the same for all the Count and upDown SoftPoint Signal types under Counter2 to Counter10 SoftPoint objects instantiated. Refer to Figure 34.
Figure 34. Renaming Count and upDown SoftPoint Signal types
Deploying a SoftPoint Configuration

Whenever new SoftPoint objects are created, or changes to existing SoftPoint objects made, the new configuration will not go into effect until the changes are deployed. While SoftPoint configurations are being deployed, SoftPoint processing is suspended, current values and new inputs are held. This process is generally completed within five minutes, even for large configurations. To do this (reference Figure 35):

1. In the Control Structure, select the **SoftPoint Generic Control Network** object for the node where the SoftPoints will be deployed.

2. Select the **Deploy** aspect.

3. Click the **Deploy button** to start the deploy process. Completion of the deploy process is indicated by the **Deploy ended** message, Figure 36.
Enabling the Calculations

The calculations will not execute until they have been assigned to a Calculations service provider and enabled. Use the Calculation Status Viewer.

To do this (reference Figure 37):

1. Open the Service Structure using the Structure selector.
2. Select the Calculation Server, Service.
3. Select the Calculation Status Viewer aspect.
4. Select the calculations in the viewer and choose Service from the context menu.

Figure 36. Deploy Ended Indication
Section 2 Configuring Basic Functionality

Enabling the Calculations

5. Use the dialog to select a service group (Figure 38) and click OK.

6. Select the calculations in the viewer and choose Enable from the context menu as shown in Figure 39.
This completes the SoftPoint/calculation configuration.

**Collecting and Viewing Historical Data**

Basic History and Information Management History Services collect and store historical information for the process. Desktop Tools is used to view the historical data. Property logs collect data from user-specified numeric (floating point or integer) aspect object properties. For this tutorial, the property logs will be configured to collect integer values from the SoftPoint signals.

The property log structure is used to integrate the basic History trending function and Information Management history logs.

The *trend* log collects directly from an OPC data source; in this case, a SoftPoint signal. The trend log resides on an 800xA system connectivity server and supports storage and viewing of operator trend data.

Information Management *History* logs support extended storage and advanced historical data management functionality including offline storage.

An example is shown in **Figure 40**. For this tutorial, the Connectivity and Information Management servers reside on the same node.
Figure 40. Example, Property Log Hierarchy

Historical collection and viewing for the SoftPoint signal is implemented by:

1. Defining a history source for the SoftPoints in the Control Structure (Configuring Node Assignment for Trend Logs).
3. Adding a Log Configuration Aspect to an Object.
4. Viewing Historical Data using DataDirect System 800xA Toolbar.

Configuring Node Assignment for Trend Logs

Trend logs require a History Source aspect to specify the connectivity server where the logs will reside. The History Source aspect must be located above the objects where the log configurations will be added.

For this tutorial, the logs will be collecting from SoftPoints residing on a SoftPoint generic control network in the Control Structure. Therefore, add the History Source as an aspect of the SoftPoint generic control network object.

This is illustrated in Figure 41.
To add a History Source aspect:

1. Open the Control Structure using the Structure selector.

2. Select **SoftPoint Generic Control Network** object in the Control Structure and choose **New Aspect** from the context menu.

*Figure 41. Using One History Source*
3. Select the **History Source** aspect in the New Aspect dialog, then click **Create**, (Figure 42).

![Figure 42. Adding History Source Aspect](image)

4. Select the History Source aspect, then use the Service Group pull-down list to select the Service Group for the node on which the SoftPoint generic control network is configured (Figure 43).

5. Click **Apply**.
Creating a Log Template

The log template establishes the log hierarchy and data collection scheme for the property logs which will be instantiated from the template.

1. Open the Library Structure using the Structure selector and select **History Log Templates, History Log Templates Library**.

2. Select **Default Templates, History Log Templates Library** and choose **New Object** from the context menu (Figure 44).

3. Select **History Log Template** in the New Object list, enter a name for the log template object that identifies the template. The name shown in Figure 44 indicates the template is for a log configuration that will collect samples at 10-second intervals, store one week of data in a trend log, and 52 weeks in a history log.

4. Click **Create**.
5. Select the new log template object in the left-hand browser and click on the Log Template aspect. This displays the aspect’s configuration view for building the log hierarchy and specifying data collection parameters (Figure 45).

The hierarchy starts with the Property Log placeholder which represents the data source (the object property for which data will be collected). All component logs in the hierarchy (trend and history) will be added under the Property Log placeholder.
Adding a Direct Trend Log

The first log in the hierarchy is a trend log which collects directly from an OPC source (in this case, a SoftPoint signal). This log will support storage and viewing of operator trend data, and will serve as the source for the Information Management log. To add the trend log:

1. Select the Property Log to highlight it and click Add.

2. From the New Log Template dialog (Figure 46) select OPC from the Source pull-down list. The Log Type defaults to Direct. The Collector Link option is NOT applicable for direct trend logs.

This log must be added as a Direct Log Type which means it will collect directly from an OPC data source.
3. Click **OK** when finished. This displays the configuration view for the direct trend log. This configuration view has two tabs as shown in Figure 47.

**Figure 46. New Log Template Dialog**

**Figure 47. Basic History Trend Log Configuration View - Log Definition Tab**
While the default log name (Log1) may be retained, it is recommended that the log be renamed to help operators when browsing for logs to view.

4. Use the **Log Definition** tab to specify a log name (**Figure 48**). Use a name that helps you recognize the function this log will perform. For example, the name in **Figure 48** identifies the log as a trend log with a one-week storage size.

   ![Figure 48. Specifying a Name for the Trend Log](image)

5. Click the **Data Collection** tab and then configure the Storage Interval and Storage Size attributes. **Figure 49** shows how to configure the log to collect samples at 10-second intervals, and hold up to one week of data.

   If the **Max Time** check box is selected, the value of the Max Time should be greater than the Min Time.
Section 2  Configuring Basic Functionality  Creating a Log Template

Figure 49. Data Collection Configuration for the Trend Log

It is also possible to add a direct log by right clicking the Property Log and selecting Add Log > OPC from the context menus (Figure 50).

Figure 50. Adding a Direct Log

Adding a Hierarchical History Log

Add a hierarchical Information Management log under the direct trend log. This log will collect from the direct trend log. It will extend the storage capacity, and support other advanced data collection/storage functions. To add this log:
1. Select the direct log and click Add.

   This displays the New Log Template dialog for a hierarchical log type. The log type defaults to Hierarchical.

2. Check Linked in the Collector Link area, and then choose IM History Log from the Server Type pull-down list, as shown in Figure 51.

   ![New Log Template](image)

   **Figure 51. Configuring a Hierarchical Information Management-type Log**

3. Click OK when finished.
It is also possible to add a hierarchical Information Management log by right clicking the direct log and selecting **Add Log > IM History Log** from the context menus (Figure 52).

![Figure 52. Adding a Hierarchical Log to the Direct Log](image)

**Configuring an Information Management Log**

The log configuration view for Information Management-based history logs has four tabs (refer to Figure 53). Most of the log attributes on these tabs have valid default values, or are not mandatory to complete the configuration.

1. Use the **Log Definition** tab to specify a Log Name and Service Group.

   The Service Group pull-down list contains all History servers defined in the Aspect System. This list may be used to specify the server where this log will reside. The list defaults to the local node. This is suitable for this tutorial.
2. Click on the **Data Collection** tab (Figure 54). For this example, this log needs to collect samples at 1-minute intervals and store 52 weeks worth of data. To do this:

   a. Configure the Sample Interval to establish the base sample rate as **10 Seconds**. Set the Storage Interval to the same value. The Sample Blocking Rate defaults to a multiple of the Sample Interval, in this case, 1 Hour. This determines the interval at which samples collected by the trend log will be forwarded to the history log.

   b. Enter the Log Period: **52 Weeks**. This determines the Log Capacity \((\text{log capacity} = \text{log period} \times \text{storage interval})\).

It is strongly recommended that the defaults be used for the calculation algorithm (Store As Is or Instantaneous do not use a calculation) and storage type. It is generally not necessary to use calculations for data collection. Desktop tools is used to perform calculations during data retrieval.
Adding a Log Configuration Aspect to an Object

Property logs are instantiated on their respective objects (in this case, SoftPoint signals) by adding and configuring a log configuration aspect for each object. The log configuration aspect specifies the object property whose values will be logged, and also specifies the log template that will establish the log structure, data collection parameters, and other log attributes.

There are two methods for adding a log configuration aspect to an object.

- Add the aspect via the Plant Explorer. This is the easiest method for adding log configuration aspects to just one or two objects.
• Use the Bulk Configuration add-ins in Microsoft Excel (extended Information Management functionality). This is the recommended method for adding a large number of log configuration aspects, especially when the aspects are being instantiated from the same Log Configuration Template.

This section first demonstrates how to add a log configuration aspect to one object via the Plant Explorer, and then shows how to add the remainder of the Log Configuration aspects using the Bulk Configuration tool.

The first aspect does not have to be added via the Plant Explorer in order to use the Bulk Configuration tool. This method is included in this tutorial to show how to add a single Log Configuration aspect using base system functionality.

Using the Plant Explorer

For this tutorial the log configuration aspects are being added to the Count Signal objects for the SoftPoint objects created in Building a Process Simulation on page 21. Reference Figure 55 for Steps 1-3 below:

1. Open the Control Structure using the Structure selector.
2. Navigate to the first Counter SoftPoint object under the SoftPoint Object group.
3. Expand the object tree for the object, select the Count Signal and choose New Aspect from the context menu.

Figure 55. Adding a History Aspect to a SoftPoint Signal Object
This displays the New Aspect dialog.

4. Select the **Log Configuration** aspect (**Figure 56**). Click **Create** (there is generally no advantage to renaming this aspect).

![New Aspect dialog](image)

**Figure 56. Selecting the Log Configuration Aspect**

This adds the Log Configuration aspect to the object’s aspect list.

5. Click the log configuration aspect in the object’s aspect list to display the configuration view (**Figure 57**).
The Logged Properties pane shows the name of the selected OPC object where the log configuration aspect has been added.

Figure 57. Log Configuration Aspect Added to the Object’s Aspect List
6. Select the OPC object name and choose **Add Property Log** from the context menu (or click the **Add Property Log** button). Refer to **Figure 58**.

![Add Property Log](image)

**Figure 58. Adding a Property Log**

This displays the New Property Log dialog (**Figure 59**). This dialog is used to select one of the object’s properties for which to collect data. This dialog also is used to select the template to establish the log hierarchy and data collection scheme.

7. From the Property list, select the **Value** property.
8. Select the **Log_10s_1W_52W** template from the Template list.
9. Click **OK** when finished.
Adding a Log Configuration Aspect to an Object

Section 2 Configuring Basic Functionality

Figure 59. New Property Dialog

The instantiated log configuration for Counter1 Count based on the selected property and log template is shown in Figure 60.

Figure 60. Instantiated Log Configuration

The status light indicates whether or not the log is connected to a history source. Green indicates good connection. Red indicates bad or no connection. If the light is red, check the History Source configuration (Configuring Node Assignment for Trend Logs on page 51).

10. Click **Apply** to create the log (log state is Inactive).
11. Select the History Log and then click the **IM Definition** tab (Figure 61).

12. Click **Activate** to activate the log. This will cause the log stat to change to active.

**Figure 61. Activating a Log**

This aspect does not require any further configuration. Some adjustments to the configuration can be made via the aspect view for each component log in the property log hierarchy; however, this procedure is not covered (nor is it required) in this tutorial. Confirm that the log is properly configured and operational by selecting a log, for example **Trend1Wk**, selecting the **Status** tab, and then clicking **Read**. Refer to **Figure 62**.

Data will not be available in the history log (History52Wk) until the interval specified by the sample blocking rate has elapsed. The default for this log configuration is 20 minutes.
Adding a Log Configuration Aspect to an Object  

Section 2 Configuring Basic Functionality

Finish adding log configuration aspects using the Bulk Configuration tool as described in the following procedure.

Using the Bulk Configuration Tool

This procedure describes how to use the Bulk Import tool in DataDirect (Microsoft Excel) to instantiate log configuration aspects for their respective signals. This tool is used to instantiate a large quantity of property logs without having to use the Plant Explorer. This can substantially reduce the time spent configuring logs.

If multiple property log configurations are created using the Bulk Import tool and Industrial IT Basic History and Information Management logs stop collecting follow these steps:

a. Locate the Basic History Service Providers for the log configurations just created.

b. Restart these Basic History Service Providers located in step a.

To configure property logs with the Bulk Configuration tool:

1. Launch Microsoft Excel and create a new workbook.
If you are logged on as a different user than the one that installed the Information Management software, then add the Bulk Import add-ins to Excel for that user. Learn about configuring Property Logs in System 800xA Information Management Configuration (*3BUR001092*).

The first time an Excel Worksheet is opened with the add-ins, a prompt to enable macros may be displayed. Macros MUST be enabled (click the Enable macros button) in order to use the add-in tools.

2. To set up the workbook for bulk configuration, choose **Bulk Import > Initialize Sheet**, Figure 63. Click **OK** to delete all sheet data.

   ![Initialize Sheet](image)

   **Figure 63. Initializing the Workbook for Bulk Configuration**

   This adds row and column headings related to bulk configuration. Also, a dialog is provided for connecting to a system, Figure 64.

3. Click **Set System** to connect the spreadsheet to the Aspect System as indicated in the Select a System dialog.
4. Import a list of object properties for which historical data will be collected - in this case the Value property of the Count SoftPoint signals. It is recommended that an import filter be applied so the import list can be limited to just those object properties needed. This minimizes the duration of the import operation and makes it easier to work with the Bulk Configuration tool.

A filter can be specified based on object name, aspect, and property as shown in Figure 65. This filter limits the list of returned properties to Value properties for all Integer PCA aspects in all Objects whose name pattern fits *Count.

Object = *Count (* is a wild card character string)
Aspect = Integer PCA
Property = NAME:Value
5. Once the filter is specified, choose **Bulk Import > Load Sheet from System**, Figure 66. This displays the Object Browser dialog.

6. Use the Object Browser to select the root object, in this case, the SoftPoint Generic Control Network object created in **Adding a New SoftPoint Object Type** on page 27. This establishes the starting point where the importer will begin looking for properties to add to the list.

7. Check the **Include child objects**, **Include Logged Properties**, and **Include All Properties** check boxes, Figure 67. This tells the importer to include in the search all child objects under the SoftPoint Generic Control network object (SoftPoint and SoftPoint signal objects).
Figure 67. Selecting the SoftPoint Process Object Group

8. Click Add. The import result is shown in Figure 68.

Note that the log configuration aspect created is also in the list. This is because the Include Logged Properties check box was selected.
Figure 68. Import Filter Result

9. For this tutorial, all logs will use the same log template and log configuration aspect name.

Every object property to be logged must have a property log template that meets the data collection requirements of the object property. Also, the name of the log configuration aspect must be specified.

These parameters are already specified for the Counter 1 object to which the log configuration aspect was added (refer to Using the Plant Explorer). Make these specifications for the remaining objects as described below.

a. Use the log template specified for the Counter 1 object property to apply the same template to any number of contiguous properties in the list by clicking the bottom right corner of the Property Template cell and pulling down to highlight the Property Template column for other contiguous properties, Figure 69. The template specification will be entered in the highlighted cells when the mouse button is released.
The Bulk Configuration tool supports other methods to specify the log template and log configuration aspect name for the first object property in the list when a Log Configuration aspect is not added via the Plant Explorer. The alternatives are:

- entering the name directly if it is known.
- using the template list dialog (available via the context menu).

These methods are not covered in this tutorial.

b. Use the same Log Configuration aspect name for all object properties in the list by copying the Log Configuration cell into the other rows in the list in the same manner as the property template.

c. Save the spreadsheet using a unique name.

It is recommended that the spreadsheet be saved before running the Bulk Configuration function. This will enable Excel to be exited without losing the configuration data in the event of a problem. Give the sheet a unique name. If Excel is opened using DataDirect, DO NOT save the sheet using the default name. DataDirect opens the default spreadsheet whenever DataDirect is opened.
10. Once the log template and log configuration aspect definitions have been filled in, run the Bulk Configuration utility to update the log aspects from the spreadsheet. To do this, choose **Bulk Import > Update Log Aspects from Sheet**, Figure 70.

**Figure 70. Updating Log Aspects from the Sheet**

11. When prompted to confirm this action, click **OK** to complete the update, **Figure 71** and then close the Bulk Import tool.

**Figure 71. Confirm Update**

12. Verify that Log Configuration aspects have been added to the specified signals by returning to the Control Structure, looking at the aspect list for one of the signals, and checking for the presence of a Log Configuration aspect.
The log operation may also be confirmed by selecting a log, selecting the Status tab, and clicking Read, Figure 72.

Figure 72. Confirming that Log Configuration Aspects Have Been Added

13. To activate all logs, Figure 73.
   a. Open the Node Administration Structure.
   b. Select the Inform IT History Object for the node.
   c. Select the Inform IT History Log List aspect.
   d. Click Update Log List if necessary to display all 10 logs.
   e. Use the context menu for one of the history logs and select Activate All.
Figure 73. Activate All Logs

Viewing Historical Data using DataDirect System 800xA Toolbar

The **Status** tab on the Log Configuration aspect is a quick way for verifying log operation and viewing log data. This section shows how to use DataDirect (Excel Data Access) for more extensive viewing and reporting capability from the desk top. The following tutorial shows how to read the SoftPoint values stored in the corresponding history logs:

1. Launch DataDirect from Excel.

DataDirect integrates add-in tools into Microsoft Excel.
DataDirect add-ins to Excel may need to be added if a different user than the one that installed the Information Management software is logged in.

Follow the procedure below to add DataDirectSystem800xA msi:

Choose **File> Options > Add-Ins** and then click **Go**. Check the **DataDirect System 800xA** check box and click **OK** on the Add-Ins screen that appears. C:\ProgramData\ABB\800xA\DataDirect\bin\ABBDataDirectSystem800xA.xlam file is added into the Excel options.

The first time an Excel Worksheet is opened with the DataDirect add-in tools, a message asking whether or not to enable macros may be shown. If this happens, click the Enable macros button to set the security level to Low for this session. Macros MUST be enabled in order to use the DataDirect add-in tools.

2. Specify the starting cell where the query result will be displayed. To do this, click the applicable cell in the Excel Spreadsheet.

3. Open the System 800xA History Values dialog by either clicking the tool bar button, **Figure 74**, or choosing **DataDirect System800xA> Industrial IT History Values** from the menu bar.

![Figure 74. Opening the History Values Dialog](image)

If these options are not available, click Options and go to the View tab to enable these options.
The History Values dialog is shown in Figure 75. This dialog provides access to both basic trend logs and Information Management history logs.

4. Use the object browser section (left side) to select the object whose logs will be accessed. The trend and history logs for the selected object will be listed in the Items list (right side). If the Include Child Objects check box is checked, the Items list will include logs for all child objects of the selected object (not shown in this example). A filter may be specified to limit the number of items; however, that is neither required nor covered in this tutorial.

5. Use the Output radio buttons to specify whether to execute a one-time (ad-hoc) data query, or insert a reusable formula. Either option is okay for this tutorial. To create a report from this spreadsheet, select the Formula option.

6. Specify whether to retrieve Raw Data or Interpolated Data.

7. A Log Calculation Algorithm (aggregate) may be applied to Interpolated Data when it is retrieved. The default is to apply no calculation (Any).

8. Specify the maximum Number of Values to return (use 100).

9. The default time span is one hour from the current time (Dynamic Time). Adjust this time span as required.

10. Select the property logs whose values are needed (Trend1Wk).

11. Click Apply or OK to retrieve the data.
Figure 75. History Values Dialog

An example query result is shown in Figure 76.
Alarm/Event Data

Alarms and events generated by the SoftPoints are collected by the system message service and may be viewed via a SoftPoint signal Alarm and Event List aspect. To support this functionality, the OPC alarm server for SoftPoints must be added to the Information Management’s Event Collector Service Group Definition. This set-up should already have been done as described in Integrating SoftPoint Alarms and System Messages on page 26.
Viewing Alarms and Events

Once this connection is established, the alarm/event data for a SoftPoint signal may be viewed via the signal’s Alarm and Event aspect Main view. Change the default configuration to: **Common Event List Configuration : Alarm and Event List Configuration** (the default is Alarm List). This list, **Figure 77**, will contain entries for events that have occurred for the selected object (CountHigh, CountLow, etc...).

![Figure 77. Viewing an Event List](image)

**Adding an Event List to the Object Type**

The Event Data may be integrated into an Excel spreadsheet for reporting purposes. This functionality is supported by the System 800xA Alarm and Event dialog in DataDirect, **Figure 78**.

As a further option, configure a message log in Information Management History to support extended online storage and offline archival alarm/event data. This is demonstrated in **Section 5, Configuring Additional Functionality**.

Since the default configuration of the Alarm and Event List aspect was to display alarms, do the following to set up an Event List for Counters 1 to 10.
1. Open the Object Type Structure to the Counter, SoftPoint Process Object Type.
2. Add a new Alarm and Event List aspect and name it Event List.
3. Change the default configuration to: **Common Event List Configuration:**
   **Alarm and Event List Configuration** (the default is Alarm List). By default, the aspect is set to inherit in the Counter Type Definition, Aspect Control.

   Go to the Control Structure to see the Event List aspect added to each Counter object.

4. Return to DataDirect and select the IIT Alarms and Events button, Figure 78.
5. Select the Counter1, Counter and then select the Event List aspect name.
6. Click **OK** to retrieve the Event List data.
7. Save the XL file as C:\Data\Reports\Counter1Trend1Wk.xls for example. Do not use the EmptyDoc.xls name.
If the ActiveX control for the Edit Filter button freezes, press the Esc key.
Section 3 Report and Scheduling for Operations

Reports are created using DataDirect or a third party application such as Excel. A report is scheduled to run using the Application Scheduler and the Report action plug-in. The System 800xA functions are as follows:

1. Process Values
2. History Values
3. Alarm and Event

Figure 79. Toolbar

The examples given in this section include:

- Creating a History Report using DataDirect System 800xA Toolbar on page 88.
- Creating a Process Value Report using DataDirect System 800xA Toolbar on page 91.
- Creating an Alarm and Event Report using DataDirect System 800xA Toolbar on page 92.
- DataDirect Report Templates for Scheduler on page 94.
Creating a History Report using DataDirect System 800xA Toolbar

This example shows how to quickly create a history report using DataDirect functionality which is included in the base functionality of the 800xA System.

1. Launch DataDirect from Excel.
2. Select a cell in the spreadsheet which will be the starting point for inserting the history data.
3. Click the History Values button, or choose **DataDirect System 800xa > Industrial IT History Values** from the menu bar and do the following to configure the dialog, **Figure 80:**

![Industrial IT History Values dialog](image)

**Figure 80. History Values Dialog**

- Use the Output radio buttons to insert a reusable formula.
- Specify raw data. The default is no calculation with this selection.
- Specify the Number of Values to return to be 100.
- Use the default time span of one hour from the current time (Dynamic Time).
Creating a History Report using DataDirect System 800xA Toolbar  

Section 3 Report and Analysis

4. The resulting report is shown in Figure 81.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Object Name</td>
<td>Calculation</td>
<td>Log Time Stamp</td>
<td>Value</td>
<td>Data Quality</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>[Control Structure]Root/IMDA/91_STANDARD/8_SIN/SIN-000001-MEASURE_Log2</td>
<td>Any</td>
<td>06-11-2015 15:01:12</td>
<td>55.06449336</td>
<td>OK</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>06-11-2015 15:02:24</td>
<td>26.82765257</td>
<td>OK</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>06-11-2015 15:03:36</td>
<td>14.94876693</td>
<td>OK</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>06-11-2015 15:04:40</td>
<td>26.50301258</td>
<td>OK</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>06-11-2015 15:05:48</td>
<td>54.9152667</td>
<td>OK</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>06-11-2015 15:06:08</td>
<td>88.10310486</td>
<td>OK</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>06-11-2015 15:07:12</td>
<td>94.92429542</td>
<td>OK</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>06-11-2015 15:08:24</td>
<td>92.95741957</td>
<td>OK</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>06-11-2015 15:09:36</td>
<td>55.35248607</td>
<td>OK</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>06-11-2015 15:10:48</td>
<td>26.6455813</td>
<td>OK</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>06-11-2015 15:11:50</td>
<td>14.5818882</td>
<td>OK</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>06-11-2015 15:12:56</td>
<td>26.3979471</td>
<td>OK</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>06-11-2015 15:13:56</td>
<td>54.6799622</td>
<td>OK</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>06-11-2015 15:14:58</td>
<td>93.7490774</td>
<td>OK</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>06-11-2015 15:15:08</td>
<td>95.36257931</td>
<td>OK</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>06-11-2015 15:15:15</td>
<td>93.3401702</td>
<td>OK</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>06-11-2015 15:15:24</td>
<td>54.76802591</td>
<td>OK</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>06-11-2015 15:15:34</td>
<td>26.9779598</td>
<td>OK</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>06-11-2015 15:15:49</td>
<td>14.97149741</td>
<td>OK</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>06-11-2015 15:16:08</td>
<td>26.52766591</td>
<td>OK</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>06-11-2015 15:16:25</td>
<td>55.3210678</td>
<td>OK</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>06-11-2015 15:20:24</td>
<td>65.5796984</td>
<td>OK</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 81. History Reports

5. Save the report file as C:\Data\Reports\Counter1History52Wk.xls.
Creating a Process Value Report using DataDirect System 800xA Toolbar

1. Launch DataDirect from Excel.
2. Select a cell in the spreadsheet which will be the starting point for inserting the history data.
3. Click **IIT Process Values** icon on the Custom ToolBar, or choose **DataDirect System 800xa > Industrial IT Process Values** from the menu bar and do the following to configure the dialog, **Figure 82**:

![Figure 82. IIT Process Value](image)

   a. Use the Output radio buttons to insert a reusable formula.
Creating an Alarm and Event Report using DataDirect System 800xA Toolbar

Section 3  Report and

b. Click either **Apply** or **OK** to retrieve the data.

4. The resulting report is shown in **Figure 83**.

![Figure 83. Process Value Report](image)

5. Save the report file as C:\Data\Reports\Counter1ProcessValues.xls.

Creating an Alarm and Event Report using DataDirect System 800xA Toolbar

1. Select a cell in a new workbook which will be the starting point for inserting the event data.

2. Click the Alarm and Events button, or choose **DataDirect System 800xa > Industrial IT Alarm and Events** from the menu bar and use the defaults to configure the dialog for the **Event List** Aspect on the **Counter1** object.
   a. Use the Output radio buttons to insert a reusable formula.
   b. Specify the Maximum Rows to return to be 100.
c. Select the Alarm and Event List Aspect whose values you want to see, in this case select the **Event List** Aspect on the **Counter1** object, Figure 84.

Figure 84. *DataDirect Alarm and Event Dialog*

   d. Click **OK** to retrieve the data.
3. The resulting report is shown in Figure 85.

Figure 85. DataDirect XL Report of Counter 1 Alarm and Event Values

4. Save the report file as C:\Data\Reports\Counter1AE.xls.

DataDirect Report Templates for Scheduler

The steps given in the previous sections can be used to create templates or the user can combine the multiple reports in the same excel sheet as a template.

Adding Report Parameters for User-defined Template

Users can create references (named cells) in a report template which can be used as input parameters in Scheduler.

The following example shows how to add a parameter in History Reports that is created in the section Creating a History Report using DataDirect System 800xA Toolbar on page 88.
1. Open the file: C:\Data\Reports\Counter1History52Wk.xls
2. Select the cell which has an object name as shown in Figure 86.

3. Click the **Formula** tab in the Excel menu.

**Figure 86. History Reports**
4. Click **Define Name**. The **New Name** dialog is displayed, **Figure 87**

![New Name Dialog]

**Figure 87. New Name Dialog**

5. Enter the **Name** that can be used as a parameter.

6. Select **Workbook** from the **Scope** drop-down list.

7. Click **OK**.

8. Save the Excel report.

To pass data into the newly created reference, refer to **Report Parameters** in the **Creating Reports** section of **System 800xA Information Management Data Access and Reports** (3BUF001094*).

---

**Attaching Report Templates to File Viewer Aspects**

The files created for reports may be saved in the Windows file system or attached to File Viewer aspects in the 800xA system aspect directory. This is used to browse for report files via the Plant Explorer, and also is used to apply version control and electronic signatures to report files. Create File Viewer aspects for the reports that can be scheduled as follows:

1. In the Plant Explorer, browse to the location where the File Viewer aspect will be added, for example, the Reports branch in the Scheduling Structure or with the object in the Control Structure. In this example, go to the Scheduling Structure/Reports branch.

2. Choose **New Object** from the Reports context menu.
3. In the New Object dialog, select the Generic type object, assign the object a meaningful name such as: GettingStartedReports then click Create.

4. Within the GettingStartedReports object create another generic object called Counter1History52Wk. This will be used for defining the Excel Report.

5. Select the new object and choose New Aspect from the context menu.

6. Select the File Viewer aspect in New Aspect dialog then click Create. This adds the File Viewer aspect to the selected object.

7. Open the Configuration view of the File Viewer aspect. To do this, either select the aspect and choose Config View from the context menu, or use the corresponding icon on the tool bar.

8. Attach the report file as a Work Document. To do this, in the Work Document section of the Configuration view, click the Attach button.

9. Use the File Browser dialog to select the report file in the Windows file system (C:\Data\Reports\Counter1History52Wk.xls in this example), then click Open.

10. The user can attach other reports in the same way as described in Step 4 through Step 9.

**Scheduling a Report**

This example shows how to schedule a report by creating a Job Description object with an Action Aspect and then setting up a Periodic Schedule in the Scheduling Definition aspect. The different type of Job Descriptions could be organized into Job Folders (DataDirect Reports, Excel Reports, Crystal Reports for example).

The Scheduler Service is automatically created during installation of Information Management. Otherwise, the Scheduler Service will have to be created.

1. In the Plant Explorer, select the Scheduling Structure.
2. Select **Job Descriptions** and choose **New Object** from the context menu, **Figure 88**.

![Figure 88. Adding a New Job Object](image)

3. Add the Job object as a **Job Description** object, **Figure 89**. Assign the object a logical name (Counter1History52Wk for the Excel Report).

![Figure 89. New Object Dialog, History Report](image)

4. Click **Create**. This creates the new job under the Job Descriptions group, and adds the Schedule Definition aspect to the object’s aspect list.
5. Select the Job Description object, Figure 90, and choose **New Aspect** from the context menu.

![Figure 90. Adding a New Aspect, History Report](image1)

6. In the New Aspect dialog, select the **Action Aspect**, Figure 91. Use the default aspect name, or specify a new name.

![Figure 91. New Action Aspect Dialog](image2)

7. Click **Create** to add the Action aspect to the job.

8. Select the Action Aspect from the object’s aspect list, Figure 92 and select the **Report Action** from the Action pull-down list.
Figure 92. Set Action Aspect as Report Action

9. Configure the Action Aspect, **Figure 93**.
Section 3  Report and Scheduling for Operations

Scheduling a Report

Figure 93. Set Output Options in Action Aspect Dialog

a. Use the Report Template Path to enter or select the report to be executed by this action. Here are the three primary examples:

- Enter a Windows file directly: C:\Data\Reports\Counter1History52Wk.xls
- Browse for a Windows file: click the Report Template Path ... button then choose Windows Files from the context menu. Select C:\Data\Reports\Counter1History52Wk.xls and click Open.
- Browse for a File Viewer aspect: click the Report Template Path ... button then choose File Viewer aspects from the context menu. Navigate to Reports / GettingStartedReports / Counter1History52Wk, select the File Viewer aspect and click OK. The path will be: Counter1History52Wk:File Viewer.

b. Optionally, select System Messages and choose Log Both Start and Done.

c. In the Output Options section, check Export Paths.
The Export Paths option is used to export the report output to one or more files of a specified type (Excel, HTML, PDF, etc.). The completed report files may be attached to Completed Report objects in the Report branch of the Scheduling Structure, be stored as Windows files, or both.

The format defaults to the format of the selected report template. In the following examples, add <TimeStamp> to get the time attached to the report and make the changes noted.

- For HistoryReport and the Counter1History, use the Add File Path button for Windows output.
  For the HistoryReport, select a Format such as HTML. Browse to the file path and add the time stamp, for example:
  C:\Data\Reports\Output\Counter1History52Wk_<TimeStamp>.html. Click OK.

- For Counter1History52Wk, use the Add Object Path button for File Viewer aspect output to a Completed Report object. In the dialog, the Format defaults to Excel (the format of the report). Edit the Object Path to be: Counter1History52Wk/Counter1History52Wk_<TimeStamp> and enter the file Name: Counter1History52Wk.xls. Click OK.

  The object path defaults to an object which is named after the selected report template with the word Folder and a time stamp appended. This object will be created in the Reports branch of the Scheduling Structure if it does not already exist. The file name defaults to the name of the selected report template. These defaults may be used instead of the suggested edits.

d. Where report parameters are needed, check Report Parameters and click the Edit Parameter List button. For example, in the case of the History Report template that is created in Adding Report Parameters for User-defined Template on page 94, set the tagname = Counter1 Count:Value, History52Wk. OK that and Close.

e. Click Apply to the Action Aspect.

f. As an option, use the context menu and select Test Action to see if the Report Action works.

10. Select the Scheduling Definition aspect and set up a Periodic Schedule, Figure 94. Disable the Schedule (Enabled unchecked). The Run Now button
will be used to test the report output. If there is more than one Service Group, then be sure to set that field also.

Figure 94. Set Periodic Schedule in Scheduling Definition Aspect

11. Set the Run every period field as desired.

12. Click Apply.

13. Click Run Now.

If the Schedule is Enabled, the default behavior is to run the first instance of the job immediately after clicking Apply and to continue running at the specified interval indefinitely. For example, if the interval is run every 1 Day, the job will start running at the time the schedule is submitted, and continue to run once-a-day at that time.
Section 4 Reports and Scheduling

Reports are created using DataDirect or a third party application such as Excel or Crystal Reports. A report is scheduled to run using the Application Scheduler and the Report action plug-in. The examples provided in this section are:

- DataDirect report templates for Scheduler. ([Creating a User-defined Report Template using DataDirect System 800xA on page 106](#)).
- Report parameters for user-defined template. ([Adding Parameters to User-defined Report Templates using DataDirect System 800xA on page 111](#)).
- History reports ([Adding Parameters to User-defined Report Templates using DataDirect System 800xA on page 111](#)).
- History reports using ODBC and ODA ([Creating a Simple History Report using ODBC and ODA on page 112](#)).
- Report parameters ([Adding Parameters to the History Report on page 117](#)).
- Real-time reports ([Creating a Real-Time Report with Excel on page 123](#)).
- Crystal reports ([Creating a History Report with Crystal Reports on page 130](#)).
- File Viewer aspects ([Attaching Report Templates to File Viewer Aspects on page 132](#)).
- Scheduling reports ([Scheduling a Report on page 133](#)).
- Historizing reports ([Historizing a Report on page 139](#)).
- Alternative report configuration ([Alternative Tag Query on page 140](#)).

DataDirect provides re-executable functions and interactive dialogs for data access when creating a report in Excel.
Excel (without DataDirect add-in) and Crystal Reports use the Open Data Access (ODA) server which supports client applications that use an ODBC data source (Excel requires Microsoft Query). The client application may connect to one ODA database.

The default connection is to an ODA database named ABBODA. Without requiring any configuration, this database supports read access to all properties for all real-time objects via the `generic_da` table, read/write access to history data via the `numericlog` table and 800xA OPC HDA server, and one custom real-time table (if added in the ODA Database Definition aspect in the Library Structure, refer to Creating a Database Object in the Open Data Access section of System 800xA Information Management Configuration (3BUF001092*).)

**Use of Log Template**

The property logs used to create the following reports were created in the previous section and based upon a History Log Template with a one week direct trend log and a 52 week hierarchical Information Management log under the direct trend log (see Creating a Log Template on page 54). Another typical example is a log template with average hourly and daily values (try creating your own History Log Template in the Library Structure). To save you from doing complex and heavy queries later, it is important to take advantage of creating templates that include your reporting requirements in advance.

**Creating a User-defined Report Template using DataDirect System 800xA**

This example shows how to quickly create a history report using DataDirect functionality which is included in the base functionality of the 800xA System.

1. Launch DataDirect from Excel.
2. Select a cell in the spreadsheet which will be the starting point for inserting the history data.
3. Click the **History Values** button, or choose **DataDirect System 800xa > Industrial IT History Values** from the menu bar and do the following to configure the dialog, *Figure 95*:

![Figure 95. History Values Dialog](image)

- a. Use the Output radio buttons to insert a reusable formula.
- b. Specify raw data. The default is no calculation with this selection.
- c. Specify the Number of Values to return to be 100.
- d. Use the default time span of one hour from the current time (Dynamic Time).
e. Select the property log whose values you want to see, in this case select the Counter 1 Count history log, History52Wk.

f. Click either **Apply** or **OK** to retrieve the data.

4. The resulting report is shown in **Figure 96**.

5. Save the report file as C:\Data\Reports\Counter1History52Wk.xls.

---

**Figure 96. DataDirect XL Report of Counter 1 History Values**

6. Select a cell in a new workbook which will be the starting point for inserting the event data.

7. Click the Alarm and Events button, or choose **DataDirect System 800xa > Industrial IT Alarm and Events** from the menu bar and use the defaults to configure the dialog for the Counter 1 Event List:

   a. Use the Output radio buttons to insert a reusable formula.

   b. Specify the Maximum Rows to return to be 100.
c. Select the Alarm and Events List Aspect whose values you want to see, in this case, select the Event List on the Counter 1 Count object, Figure 97.

![DataDirect Alarm and Event Dialog](image)

*Figure 97. DataDirect Alarm and Event Dialog*

d. Click OK to retrieve the data.
8. The resulting report is shown in **Figure 98**.

9. Save the report file as C:\Data\Reports\Counter1AE.xls.

**Figure 98. DataDirect XL Report of Counter 1 Alarm and Event Values**
Adding Parameters to User-defined Report Templates using DataDirect System 800xA

Users can create references (named cells) in a report template that can be used as input parameters in Scheduler.

The following example shows how to add a parameter in History Reports that is created in the section Creating a User-defined Report Template using DataDirect System 800xA on page 106.

1. Open the file: C:\Data\Reports\Counter1History52Wk.xls
2. Select the cell which has an object name as shown in, Figure 99.

Figure 99. History Reports
3. Click the **Formula** tab in the Excel menu.
4. Click **Define Name**. The **New Name** dialog is displayed, Figure 100.

![New Name Dialog](image)

**Figure 100. New Name Dialog**

5. Enter the **Name** that can be used as a parameter.
6. Select **Workbook** from the **Scope** drop-down list.
7. Click **OK**.
8. Save the Excel report.

To pass data into the newly created reference, refer to **Report Parameters** in the **Creating Reports** section of **System 800xA Information Management Data Access and Reports (3BUF001094*)**.

**Creating a Simple History Report using ODBC and ODA**

This example shows how to create a simple report using Open DataBase Connectivity (ODBC) and Open Data Access (ODA) with Excel functionality. ODA supports real-time and historical data access for third party applications including Crystal Reports, Microsoft Excel (when used without DataDirect add-ins), and Visual Studio 2008 applications. ODA is a general term that refers to basic data access options - ODBC access.

The following activities are covered.
- Querying the database.
- Adding filtered data to the report.
- Using Information Management Browser to browse for log names.
1. Launch DataDirect from Excel.
2. Select Data > From Other Sources > From Microsoft Query…, Figure 101.

Figure 101. New Database Query
3. Choose the ABBODA* data source, Figure 102, and click OK.

![Figure 102. Choose Data Source](image)

4. Choose the LOGNAME, TIMESTAMP and DATAVALUE columns in the Query Wizard from the NUMERICLOG table, Figure 103, and click Next>.

![Figure 103. Choose Columns](image)
5. Set the filter data to equals for LOGNAME and make it equal to Counter1 Count:Value,History52Wk, Figure 104. Another way to get this value is by copying and pasting as follows:
   a. Select ABB Start Menu > ABB Industrial IT 800xA > Information Management > Utilities > IM Structure Browser.
   b. In the Browse Object dialog, select the Control Structure context menu item Get Entire List.
   c. Select the Counter1 Count:Value,History52Wk context menu item Copy Item(s).
   d. Return to the Query Wizard - Filter Data dialog and Paste the item into fill-in box.

6. Click Next> after setting the Query Wizard - Filter Data.

   ![Query Wizard - Filter Data](image)

   Figure 104. Filter Columns

7. Click Next>.

8. Click Finish.

9. Select OK on the Import Data dialog (set the option of 'Existing worksheet:' to refer existing worksheet with cell as A7, like =$A$7).
10. The completed report is shown in the Excel worksheet, **Figure 105**.

![Completed Simple Report](image)

**Figure 105. Completed Simple Report**

11. Save the report as C:\Data\Reports\SimpleReport_History52Wk.xls.
Adding Parameters to the History Report

This example uses the completed simple report as the basis for a report of multiple logs and for a time specified on the spreadsheet. This is accomplished using parameters to specify the log names and the timestamp.

1. Open the SimpleReport_History52Wk.xls.
2. Type in the desired time range to the spreadsheet, Figure 106.
3. Add the log name 'Counter1 Count:Value,History52Wk' to cell A3 on the spreadsheet. It will be used when defining parameters later.
4. From Logname, use the context menu to select Table > Edit Query, Figure 107.
5. In the Query Wizard, click Next > three times and then select: View data or edit query in Microsoft Query at the Finish dialog.
6. Click Finish to open the Microsoft query from ABBODA.

![Figure 106. Time Range Added to Simple History Report](image)

Figure 106. Time Range Added to Simple History Report
Instead of using a fixed log name, replace the Value: ‘Counter1 Count:Value,History52Wk’ with a parameter called [Input_Logname], Figure 108.
Section 4  Reports and Scheduling

Adding Parameters to the History Report

8. Copy and paste the ‘Counter1 Count:Value,History52Wk’ from cell A3 on the spreadsheet into the Enter Parameter Value dialog and click OK.

9. Add Timestamp as a parameter, Figure 109, in the Criteria Field.

Figure 108. Using Parameter for Log Name

Figure 109. Adding Timestamp Parameter
10. Set up the Value field to use 'Between [Input_From] AND [Input_To]' as the parameters. The Enter Parameter Value for the Input_From parameter is copied from the Date&Time From column of the spreadsheet, Figure 110, and the Input_To parameter is similarly copied from the To column.

<table>
<thead>
<tr>
<th>Time range</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
</tr>
<tr>
<td>Year</td>
</tr>
<tr>
<td>Month</td>
</tr>
<tr>
<td>Day</td>
</tr>
<tr>
<td>Date</td>
</tr>
<tr>
<td>Time</td>
</tr>
</tbody>
</table>

Figure 110. Copying Time Range Added to [Input_From] Parameter
11. To link the parameters to the cells, close the Microsoft Query wizard and select the LOGNAME header on the spreadsheet and use the context menu to select Parameters, Figure 111.

![Figure 111. Selecting Parameters](image-url)
12. Link the Input_Logname parameter as shown in Figure 112.

![Figure 112. Linking the Input_Logname Parameter](image)

13. Do the same to link the Input_From and Input_To parameters to their Date&Time fields.

14. As a test, change the Counter1 Count:Value,History52Wk from cell A3 to Counter2 Count:Value,History52Wk and the report will show those data values. Change it back when done.

15. Since we do not need to show the LOGNAME column, use Edit Query again, Figure 107, to remove the column.
16. Format the cells for Timestamp to show hours only.

17. To add multiple logs, copy the Counter1 Count:Value,History52Wk from cell A3 to another cell and name it Counter6 Count:Value,History52Wk. The TIMESTAMP column is not needed for the additional logs so it can be removed like LOGNAME column was done earlier. Refer to Figure 113.

18. Save the report as C:\Data\Reports\SimpleReport_History52Wk.xls

Creating a Real-Time Report with Excel

This example shows how to create a real-time report by importing ODA NUMERICLOG data into Excel. The following activities are covered.

- Browse for lognames.
- Specify a time range in the report.
- Add parameters to the Excel report to make them general.
- Add multiple logs and parameters.
1. Launch DataDirect (Excel Data Access) and open the Workplace Explorer to the Control Structure.

2. Select the Counter 1 Count softpoint object, Figure 114, and then select the Log Configuration aspect.

3. Select the Value property in the Log Configuration aspect configuration view.

4. Place the Counter1 Count Integer PCA: Value property into Excel, Figure 115.

5. Add labels for these values, Figure 116.
Figure 115. Place Value Property into Excel

Figure 116. Add Labels to the Value Property
6. Select **Data > From Other Sources > From Microsoft Query**, Figure 117.

7. Choose the ABBODA* data source and click **OK**.

8. Choose the **Name**, **Property** and **Value_Flt** Columns in the Query Wizard from the GENERIC_DA table and click **Next >**.

9. Set the filter data to equals for Name and Property and make it equal to the cell values (use copy and paste), Figure 118 and click **Next >**.
10. Select **View data or edit query in Microsoft Query** and click **Finish**, Figure 119.

---

**Figure 118. Filter Data Columns**

**Figure 119. View Data Option**
11. Use parameters as input to make the report re-usable, Figure 120. Enter parameter values for Name [Parameter1] and Property [Parameter2].

![Figure 120. Enter Parameter Values](image)

12. Remove the Name and Property columns so they do not get exported to the report (only the value will be exported).


14. Import the query data, Figure 121, into a cell and click OK.
15. From the Parameters dialog, Figure 122, set both parameters to Get the value from the following cell and to Refresh automatically when cell value changes and click OK.
16. Repeat Step 4 through Step 15 for Counter2 Count and all tags needed in the report.

Creating a History Report with Crystal Reports

This example shows how to create a Crystal report using the localhost ODBC link to access the Oracle IM Numeric log.

1. Start Crystal Reports.
   a. Select ODBC (RDO) as the data source.
   b. Select ABBODA as the ODBC (RDO) data source and click Finish.
   c. Expand ODBC (RDO) > ABBODA > SCHEMA > OAUSER and select NUMERICLOG from the Available Data Sources, add it to the Selected Tables list and click NEXT >.
4. Select the fields to include in the report.
   a. Add the following fields to display:
      – LOGNAME
      – DATAVALUE
      – TIMESTAMP
      and click NEXT >.
   b. Add NUMERICLOG.LOGNAME to Group By and click NEXT >.
   c. Click NEXT > at the Summaries option. The default NUMERICLOG.DATAVALUE is used.
   d. Click NEXT > at the Group Sorting option (None = no sort specified).
   e. At the Line Chart option, select a Line Chart and click Finish (no filters or layout templates will be used). The report opens to the Preview tab.
   f. Change to the Design tab.
g. Select **View > Field Explorer** if it does not already show.

5. To dynamically change the LOGNAME field for each report instance, it must be passed as a parameter. From the Field Explorer:
   a. Select the **Parameter Fields** branch.
   b. Select **New** from the context menu.
   c. In the Create New Parameter dialog enter the parameter name as **Log Name** and set the Value type to String. This will create the {Log Name} parameter.
   d. Set the **Allow Multiple values** options to **true** under the Value Options section.
   e. Select the **Default Values...** row and enter the value: `Counter1 Count:Value,History52Wk` as one of the default property log values in the report. Do the same for other counter logs (`Counter2 Count:Value,History52Wk`) and click **OK**.
   f. Click **OK** to close the Create New Parameter dialog.

6. Configure the query to get data as follows.
   a. The LOGNAME only needs to be in the header of the report so it can be Cut from the body (Group Details area only prints TIMESTAMP and DATAVALUE) and Pasted back into the Page Header.
   b. Select the LOGNAME field from the Page Header area, and select **Select Expert Record** from the context menu.
   c. Set NUMERICLOG.LOGNAME so that it “is equal to” {Log Name}. The formula is: `{NUMERICLOG.LOGNAME} = {?Log Name}`.
   d. Click **OK**.

7. Preview the report.
   a. Click the **Preview** tab.
   b. For the Log Name parameter, select **Discrete Value: Counter1 Count:Value,History52Wk**.
   c. Click **OK**.
Attaching Report Templates to File Viewer Aspects

The files created for reports may be saved in the Windows file system or attached to File Viewer aspects in the 800xA system aspect directory. This is used to browse for report files via the Plant Explorer, and also is used to apply version control and electronic signatures to report files. Create File Viewer aspects for the reports that can be scheduled as follows:

1. In the Plant Explorer, browse to the location where the File Viewer aspect will be added, for example, the Reports branch in the Scheduling Structure or with the object in the Control Structure. In this example, go to the Scheduling Structure / Reports branch.

2. Choose New Object from the Reports context menu.

3. In the New Object dialog, select the Generic type object, assign the object a meaningful name such as: GettingStartedReports then click Create.

4. Within the GettingStartedReports object create another generic object called Counter1History. This will be used for defining the Crystal Report.

5. Select the new object and choose New Aspect from the context menu.

6. Select the File Viewer aspect in New Aspect dialog then click Create. This adds the File Viewer aspect to the selected object.

7. Open the Configuration view of the File Viewer aspect. To do this, either select the aspect and choose Config View from the context menu, or use the corresponding icon on the tool bar.

8. Attach the report file as a Work Document. To do this, in the Work Document section of the Configuration view, click the Attach button.

d. Press F5 to Refresh Report Data, select Prompt for new parameter values and click OK.

e. Remove parameter Counter1 Count:Value,History52Wk and Add parameter Counter2 Count:Value,History52Wk to see the same report with the new parameter.

8. Save the report as C:\Data\Reports\Counter1History.rpt and close it.
9. Use the File Browser dialog to select the report file in the Windows file system (C:\Data\Reports\Counter1History.rpt in this example), then click **Open**.

10. Create a new generic object with a File Viewer aspect for each report type and place it in GettingStartedReports as described in steps 4 through 9. Select from the following reports created using this tutorial:
   - Counter1History52Wk.xls
   - Counter1AE.xls
   - SimpleReport_History52Wk.xls
   - HistoryReport.xls
   - Counter1History.rpt

**Scheduling a Report**

This example shows how to schedule a report by creating a Job Description object with an Action Aspect and then setting up a Periodic Schedule in the Scheduling Definition aspect. The different type of Job Descriptions could be organized into Job Folders (DataDirect Reports, Excel Reports, Crystal Reports for example).

The Scheduler Service is automatically created during installation of Information Management. Otherwise, the Scheduler Service will have to be created.

1. In the Plant Explorer, select the **Scheduling Structure**.

2. Select **Job Descriptions** and choose **New Object** from the context menu, **Figure 123**.

   ![Figure 123. Adding a New Job Object](image)

3. Add the Job object as a **Job Description** object, **Figure 124**. Assign the object a logical name (Counter1History for the Crystal Report).
4. Click **Create**. This creates the new job under the Job Descriptions group, and adds the Schedule Definition aspect to the object’s aspect list.

5. Select the Job Description object, **Figure 125**, and choose **New Aspect** from the context menu.

6. In the New Aspect dialog, select the **Action Aspect**, **Figure 126**. Use the default aspect name, or specify a new name.
7. Click **Create** to add the Action aspect to the job.

8. Select the Action Aspect from the object’s aspect list, **Figure 127** and select the **Report Action** from the Action pull-down list.

---

**Figure 126. New Action Aspect Dialog**

**Figure 127. Set Action Aspect as Report Action**
9. Configure the Action Aspect, Figure 128.

![Figure 128. Set Output Options in Action Aspect Dialog](image)

- a. Use the Report Template Path to enter or select the report to be executed by this action. Here are the three primary examples:
  - Enter a Windows file directly: C:\Data\Reports\HistoryReport.xls.
  - Browse for a Windows file: click the Report Template Path ... button then choose **Windows Files** from the context menu. Select C:\Data\Reports\Counter1History.rpt and click **Open**.
  - Browse for a File Viewer aspect: click the Report Template Path ... button then choose **File Viewer** aspects from the context menu. Navigate to Reports / GettingStartedReports / Counter1History52Wk, select the File Viewer aspect and click **OK**. The path will be: Counter1History52Wk:File Viewer

- b. Optionally, select System Messages and choose **Log Both Start and Done**.

- c. In the Output Options section, check **Export Paths**.
The Export Paths option is used to export the report output to one or more files of a specified type (Excel, Crystal Report, HTML, PDF, etc....). The completed report files may be attached to Completed Report objects in the Report branch of the Scheduling Structure, be stored as Windows files, or both.

The format defaults to the format of the selected report template. In the following examples, add <TimeStamp> to get the time attached to the report and make the changes noted.

- For HistoryReport and the Counter1History, use the Add File Path button for Windows output.
  For the HistoryReport, select a Format such as HTML. Browse to the file path and add the time stamp, for example: C:\Data\Reports\Output\HistoryReport_<TimeStamp>.html. Click OK.
  For the Crystal Report, select a Format such as PDF. Browse to the file path and add the time stamp, for example: C:\Data\Reports\Output\Counter1History_<TimeStamp>.pdf. Click OK.

- for Counter1History52Wk, use the Add Object Path button for File Viewer aspect output to a Completed Report object. In the dialog, the Format defaults to Excel (the format of the report). Edit the Object Path to be: Counter1History52Wk/Counter1History52Wk_<TimeStamp> and enter the file Name: Counter1History52Wk.xls. Click OK.

The object path defaults to an object which is named after the selected report template with the word Folder and a time stamp appended. This object will be created in the Reports branch of the Scheduling Structure if it does not already exist. The file name defaults to the name of the selected report template. These defaults may be used instead of the suggested edits.

d. Where report parameters are needed, check Report Parameters and click the Edit Parameter List button. In the case of the Crystal Report, set the Log Name = Counter1 Count:Value,History52Wk. OK that and Close.

e. Click Apply to the Action Aspect.

f. As an option, use the context menu and select Test Action to see if the Report Action works.
10. Select the **Scheduling Definition** aspect and set up a **Periodic Schedule**, Figure 129. Disable the Schedule (Enabled unchecked). The **Run Now** button will be used to test the report output. If there is more than one **Service Group**, then be sure to set that field also.

11. Set the **Run every** period as desired.

12. Click **Apply**.

13. Click **Run Now**.

If the Schedule is Enabled, the default behavior is to run the first instance of the job immediately after clicking **Apply** and to continue running at the specified interval indefinitely. For example, if the interval is run every **1 Day**, the job will start running at the time the schedule is submitted, and continue to run once-a-day at that time.

![Figure 129. Set Periodic Schedule in Scheduling Definition Aspect](image)
14. View the report output:
   - Open the C:\Data\Reports\Output\HistoryReport_<TimeStamp>.html file to see the first instance of the job.
   - Open the C:\Data\Reports\Output\Counter1History_<TimeStamp>.pdf file to see the first instance of the job.
   - Open the Reports / GettingStartedReports / Counter1History52Wk objects and select the File Viewer aspect of the Completed Report object, Counter1History52Wk_<TimeStamp>. Choose to Open the read only file.

**Historizing a Report**

Report logs hold the finished output from executed reports. Completed reports may also be stored as completed report objects in the Scheduling Structure. In either case the Report action must be configured to send the report to a report log, or a completed report object.

This example shows how to historize a report.

1. In the Plant Explorer, select the **Node Administration Structure**.
2. Navigate to and expand the object tree for the node where the report log will be added.
3. In the object tree for the selected node, navigate to **IM_Inform IT History_nodeName, Service Provider > Inform IT History Object**.
   Under the InformIT History Object there will be containers for each of the Inform IT History object types. The History objects (in this case, a report log) must be instantiated under the corresponding Report Log Container.
4. Select the **Report Logs** group and choose **New Object** from the context menu. This displays the New Object dialog with the Inform IT Report Log object type selected.
5. Enter a name for the object in the Name field, for example: ReportLog1, then click **Create**. This adds the object under the Report Logs group, and creates a corresponding Inform IT history Report Log aspect.
6. Specify the following for the Report Log then click **Apply**.
– Capacity = 10 (If a log is full, new entries replace the oldest entries).
– Access Name = ReportLog1 (64 characters maximum, do not use spaces).

7. Click **Mode** button and activate the Report Log from the aspect view of Inform IT History Report Log aspect.

8. Return to the Action Aspect for a report and do the following:
   a. Check **Save To History**.
   b. Click **Set**.
   c. Navigate to and select the ReportLog1 object just created and click **OK**.
   d. Click **Apply**.
   e. In the Scheduling Definition aspect, click **Run Now**.

   a. Click the **Retrieve** tab.
   b. Enter the retrieval criteria, then click **Retrieve**.
   c. In the upper pane, select the log which contains the report to be viewed ($HSReportLog1-1-o).
   d. In the lower pane, select the report.
   e. Click **View Selected Report** button and open the file for read only viewing.

**Alternative Tag Query**

The following procedure describes a simple way to query the 800xA database for numeric logs and tags using the Information Management Bulk Import functions and their filtering mechanisms available in Microsoft Excel. The query results can be used in various Inform IT and System 800xA Excel reports. The procedure consists of the following parts:
- **Create Workbook (Spreadsheet)** on page 141.
- **Configure Bulk Import Filter** on page 141.
- **Fill Workbook** on page 142.
Create Workbook (Spreadsheet)

To start the report creation process:

1. Launch Microsoft Excel and create a new workbook.
2. Select Bulk Import > Initialize Sheet.
3. Click Set System to connect the workbook to the system.

Configure Bulk Import Filter

The second step in the process is to configure the Bulk Import filter so that only the desired information is retrieved:

1. Enter the data type in the Data Type cell of the Import Filter row manually or
   a. Right click in the Data Type cell and select Data Type List.
   b. Select the data type in the Data Type List window and click OK.
   c. Click outside the cell to register the information.

A filter can be specified based on object name, aspect, and property as shown in Figure 130. This filter limits the list of returned properties to Value properties for all Integer PCA aspects in all Objects whose name pattern fits *Count.

Object = *Count (* is a wild card character string)
Aspect = Integer PCA
Property = NAME:Value
The third step in the process is to retrieve the information and place it on the first sheet of the workbook:

1. Select **Bulk Import > Load Sheet from System**.
2. Select an object within the Aspect Directory to limit/direct the search (and options if necessary) and click **Add**.

**Customize Report (Sheet)**

The fourth and final step of the process is to configure another sheet to display the desired information by using DataDirect and Excel commands and functions. The commands and functions can reference the tags and logs found on the sheet generated by the query.
Section 5 Configuring Additional Functionality

The lessons in this section describe:

- **Configuring a Message Log** for extending online storage and offline archival. This includes:
  - Check the data access connection for reading the message log.
  - Using DataDirect to retrieve alarm/event data from the log.
- **Configuring Historical Data Archiving** for process (numeric) and alarm/event data.
- **Accessing Archive Data** to publish an archive volume and read archived data.
- **Inform IT Authentication** describes how to configure authentication for an Inform IT Calculation Aspect.

These lessons are not covered in the same detail as the one in *Section 2, Configuring Basic Functionality*. It is expected that you have worked through the lessons in that section before using the lessons here.

**Configuring a Message Log**

All alarm and event messages for the 800xA system, including Process, Operator, and Audit Trail messages, are collected and stored by the 800xA Event Storage Service. This provides a short-term storage facility of 10,000 events of each type. The messages can be organized into filtered lists for viewing.
If the system has an Information Management History Server installed, the messages stored by 800xA Event Storage Service may be forwarded to an Information Management message log for extended online storage, Figure 131.

For this tutorial, an OPC message log is being configured to record alarms generated by the Count SoftPoint signals that cross their configured limiter trip points (Configuring Alarm Trip Points on page 31).

**Message Log Configuration Procedure**

Message logs are added as objects under the applicable Information Management server in the Node Administration Structure. To do this (reference Figure 132):

1. In the Plant Explorer, select the **Node Administration Structure**.
2. Navigate to and expand the object tree for the node where the message log will be added (for example, ENG64 in Figure 132).
3. In the object tree for the selected node, navigate to **IM_Inform IT History_YourNode, Service Provider > Inform IT History Object**.

Under the Inform IT History Object, there will be containers for each of the Inform IT History object types. The History objects (in this case, a message log) must be instantiated under the corresponding container.
Figure 132. Adding a Message Log Object

4. Select the Message Logs, Message Log Container and choose New Object from the context menu. This displays the New Object dialog with the Inform IT Message Log object type selected.

5. Enter IMMSGLOG for the object in the Name field. This name must be used to automatically generate the actual message log name plus the node’s IP address in the Message Log Configuration dialog.

6. Click Create. This creates a new message log object.

Specify Message Log Operating Parameters

Select the Inform IT History Message Log aspect to configure the message log.

1. Select OPC_MESSAGE for the Message Log Type. Do not change the default access name IMMSGLOG plus the node’s IP address.
2. Specify the log capacity (maximum number of messages the log can hold). Use defaults for all other log attributes.

The capacity used for the message log should match the selection made when the Oracle database was created. If the message log capacity exceeds the value specified during the IM history database creation, the IM message log may run out of space and other performance problems will eventually occur.

3. Click **Apply** when done.

### Reading the Message Log

This section describes how to read the message log using DataDirect.

### Verifying the Data Provider Connection

The ADO data provider for Oracle access must be started in order to access the Information Management message log. This set-up should already have been done as part of post-installation. To quickly verify this, launch the ADSS tool from the Windows Control Panel, Figure 133 (Control Panel is in Classic View), and verify that the ADO data provider is started and the StartupMode is set to AUTOMATIC, Figure 134.

![Figure 133. Launching the ADSS Config Tool From the Windows Control Panel](image-url)
If the data provider is started and the log cannot be accessed, check the Oracle Local Net Service name and Oracle Data Source configurations as described in the post-installation instructions for Information Management.

**Starting DataDirect**

Launch DataDirect from Excel. Log in and connect to the data server.

**Enabling the Menu/Tool Bar Options for the Message Log Dialog using DataDirect Inform IT**

By default, the menu and tool bar options for the message log dialog are not displayed. They must be enabled via the View tab on the options dialog. To do this click the options button on the tool bar (1), then select the View tab (2) and check the Message Log check boxes in the Inform IT section (3), Figure 135. Click OK (4).
Retrieving Messages using DataDirect Inform IT Toolbar

1. Specify starting cell where the query result will be displayed. Then click the Message Log button, Figure 136.

Figure 135. Enabling the Message Log Tool Bar and Menu Options

Figure 136. Message Log Button
2. Select the **OPC/Audit Trail** tab, Figure 137.

3. Select the log name from the pull-down list, then specify the time range, and other criteria to retrieve the required data.

4. Select the OPC attributes to retrieve, for example, LOCALTIME, SOURCE, MESSAGE, CONDITION, and SUB_COND.

5. Click **OK**.

![Figure 137. Message Log - OPC/Audit Trail Tab](image)

The query result is output to the active worksheet, Figure 138. The presentation is formatted according to formatting options which are available directly on the corresponding tab.
Figure 138. Message Retrieval Result

6. Optionally, save the file as C:\Data\Reports\Output\IMMSGLOG.xls.

Configuring Historical Data Archiving

The archive function supports permanent offline storage for:

- Numeric process data stored in history logs,
• Finished reports stored in report logs or stored as FileViewer aspects,
• Production data from batch control applications and stored in Production Data Logs (PDLs),
• Alarm messages,
• Event messages (including audit trail events), and
• System messages generated by 800xA system applications and stored in message logs.

This tutorial shows how to archive numeric historical data (steps 1-4). Archival for other data types is similar. The tutorial in steps 5-7 describes how to access your archive data.

1. Adding an Archive Device on page 151.
2. Adding the Archive Group Object on page 155.
3. Adding Archive Groups on page 155.
4. Setting Up the Archive Schedule for an Archive Group on page 158.
5. Publishing an Archive Volume on page 164.
6. Accessing Published Logs on page 165.
7. Viewing Published Archive Data with DataDirect on page 169.

Adding an Archive Device

Archiving is managed by one or more archive device objects which are configured in the Node Administration Structure. An archive device is a logical entity that defines where and how archive data is written. Every storage device used for archiving must have at least one archive device aspect configured for it.

To add an Archive Device object (reference Figure 139 for steps 1-4):

1. In the Plant Explorer, select the Node Administration Structure.
2. Expand the object tree for the node where the archive device will be added (for example, ROC90 in Figure 139).
3. In the object tree for the selected node, expand the **IM_Industrial IT Archive_Name**, Service Provider and select the **Industrial IT Archive** object.

4. Select the **Archive Service Aspect** from this object’s aspect list.

5. Click **Archive Device** in the Create New Archive Object section. This displays the New Archive Device dialog, Figure 140.

---

**Figure 139. Adding an Archive Device in the Node Administration Structure**

**Figure 140. New Archive Device Object Dialog**
6. Enter a name for the object in the Name field, for example: ArchDev1, then click **OK**.

This adds the Archive Device object under the Industrial IT Archive object and creates and opens an Archive Device aspect for the new object. Use this aspect to configure the device. The Archive Device aspect Config view is shown in **Figure 141**.

![Figure 141. Archive Device Aspect Configuration View](image)

7. **Table 2** describes the parameters which MUST be configured for archive. There are several parameters related to features which are useful and highly recommended, but which are not covered here. For example, it is strongly recommended that the archive backup feature be used. These features are fully covered in the section on Archiving in *System 800xA Information Management Configuration Instruction (3BUF001092)*.
Table 2. Archive Device Configuration Parameters

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Archive Path</td>
<td>c:\Archive1</td>
<td>This is the location where archive data will be written on the hard disk. A directory MUST be included in the path when using a hard disk media.</td>
</tr>
<tr>
<td>Device Type</td>
<td>Disk Drive</td>
<td></td>
</tr>
<tr>
<td>Device Behavior</td>
<td>Wrap When Full</td>
<td></td>
</tr>
<tr>
<td>Volumes</td>
<td>3</td>
<td>Number of volumes on the media that this archive device can access. Creates specified number of Archive Volume object under the Archive Device object,</td>
</tr>
<tr>
<td>Volume Quota</td>
<td>650</td>
<td>Size of each volume in megabytes (100M min). Size volumes on hard disk to match size of ROM media to which the archive data will be copied, for example 650 MB for CD ROM, or 4000 MB for DVD.</td>
</tr>
<tr>
<td>Volume Name Counter</td>
<td>1</td>
<td>Number is incremented and appended to the Volume ID each time the volume is initialized. This makes unique volume ID. Use the default.</td>
</tr>
<tr>
<td>OverWrite Timeout</td>
<td>1 hour</td>
<td>The time since the last write to an archive volume before it will be overwritten.</td>
</tr>
</tbody>
</table>

8. Click Apply to the Archive Device dialog.

**Activate the Archive Device**

The device must be active in order to archive data to, or restore data from the device. If the device was not activated during configuration, go to the main view of the Archive Device aspect and choose Activate or Deactivate from the Actions button.

Each new archive volume must be initialized prior to archiving data on it. For scheduled archives, volumes are automatically initialized if the device behavior is set to Advance When Full or Wrap When Full. For manual archives, the volume must be manually initialized. Select the archive volume and choose the Initialize command from the Action button or context menu.
Adding the Archive Group Object

Archive groups support scheduled or manual archiving for a group of logs as a single unit. This is done through an archive group object. One or more archive groups may be added to this object. Each group specifies a set of items (logs and/or aspect objects) to be archived as a unit.

Typically, this object is added under the Industrial IT Archive object in the Node Administration Structure. To do this:

1. In the Plant Explorer, select the **Node Administration Structure**.
2. Navigate to and expand the object tree for the node where the archive group is to be added.
3. In the object tree for the selected node, expand the **IM_Industrial IT Archive_NodeName**, **Service Provider** and select the **Industrial IT Archive** object.
4. Select the **Archive Service Aspect** from this object’s aspect list.
5. Click the **Archive Group** button. This displays the New Archive Group dialog, **Figure 142**.

![New Archive Group Object Dialog](image)

*Figure 142. New Archive Group Object Dialog*

6. Enter a name for the object in the Name field, then click **OK**.

This adds the Archive Group object under the Industrial IT Archive object and creates an Archive Group aspect for the new object.

**Adding Archive Groups**

Use this aspect to configure one or more archive groups:
1. Use the context menu inside the archive groups window (or click **Actions**) and choose **New Group**, Figure 143. This displays the Add Archive Group dialog.

![Figure 143. Adding an Archive Group](image)

2. Use this dialog to specify the Group name, description (optional), and the Industrial IT Archive Service Group whose service provider will manage this archive group, Figure 144. Click **OK** when finished.

![Figure 144. Add Archive Group Dialog](image)

3. Repeat this to add as many groups as required.
4. Click **Apply** in Archive Group aspect view.
Adding Entries to Archive Groups

This procedure specifies the logs (and/or objects) to be archived as part of this archive group. Different entry types can be mixed in the same group. To add entries:

1. Select the archive group from the list of archive groups and choose **New Entry** from the context menu, **Figure 145**.

   ![Figure 145. Adding a New Entry](image)

   This displays the Add Group Entry dialog.

2. Use this dialog to select an entry type. In this case use the default (Numeric), **Figure 146**, then click **OK**. The other options are described in the section on configuring archive in the Information Management Configuration book.

   ![Figure 146. Add Archive Group Dialog, Entry Type](image)

   Selecting this option displays the Add Archive Group Numeric Log Entry dialog, **Figure 147**.

3. Use this dialog to browse the aspect directory for the object whose property log(s) will be included in the archive group. In this case, select the SoftPoints object (or the Generic Control Network object).
4. Check the **Include Child Objects** check box to include logs for all child objects of the selected object (all instantiated SoftPoint objects in the Generic Control network).

5. Set the Collector Link Filter to use the IM History Log.

6. Click **OK**.

7. Click **Apply** and close the dialog.

![Add Archive Group Numeric Log Entry dialog](image)

*Figure 147. Add Archive Group Numeric Log Entry, IM Objects Entry*

To set up a schedule for an archive group, see **Setting Up the Archive Schedule for an Archive Group** on page 158.

**Setting Up the Archive Schedule for an Archive Group**

Scheduling instructions for an archive group are specified by adding a job in the Scheduling Structure, and configuring the job’s scheduling definition aspect. The schedule may be cyclic, periodic, weekly, monthly, a list of dates and times, or conditional. In addition to periodic or event-driven scheduling, manual archive operations may be executed on demand. The schedule is associated with a specific archive group via the Archive action aspect which must be added to the job object.
This section quickly demonstrates how to add a job and use the scheduling definition aspect to set up a periodic schedule. It also describes how to add and use the Archive action aspect. For further information on jobs and scheduling options, refer to the section on scheduling in the System 800xA Information Management Data Access and Reports instruction (3BUF001094*).

Adding a Job and Specifying the Schedule

Jobs are created in the Scheduling Structure. To create a job:

1. In the Plant Explorer, select the Scheduling Structure.

2. Select Job Descriptions and choose New Object from the context menu, Figure 148.

3. Add the Job object as a Job Description object, Figure 149. Assign the object a logical name.
4. Click **Create**. This creates the new job under the Job Descriptions group, and adds the Scheduling Definition aspect to the object's aspect list.

5. Click on the **Scheduling Definition** aspect to display the configuration view, Figure 150. This figure shows the scheduling definition aspect configured as a periodic schedule. A new archive will be created every three days, starting June 5, 2010 at 7:30 PM, and continue indefinitely.
Adding and Configuring the Archive Action

Actions are implemented as aspects on an object which is on or under a job description in the Scheduling Structure.

To add an action:

1. Select the Job object (for example ROC90Archive in Figure 151) and choose New Aspect from the context menu.
2. In the New Aspect dialog, select **Action Aspect** from a list presentation. Use either the default aspect name, or specify a new name.

3. Click **Create** to add the Action aspect to the job.

4. Click on the Action aspect to display the configuration view.

5. Select **Archive Action** from the Action menu.
6. Select the archive group to be scheduled by this action (in this case ArchiveGroup1:ROC90Numeric).

7. Select the Service Group (IM_ROC90).

8. Select the Archive Device (ArchDev1).

9. Click **Apply**. The defaults may be used for all other settings.

### Performing a Manual Archive

To have archive data to view in Viewing Published Archive Data with DataDirect, do the following.

1. Go to the **Node Administration Structure**.

2. Select the Archive Group object for the Industrial IT Archive of the selected node.

3. Select the Archive Group aspect.

4. Select the Archive group and use the context menu to select **Manual Archive**...

5. Click **OK** in Manual Archive dialog with Device as ArchDev1 and Volume as 1.

   Archive Volume 1 must be initialized manually prior to manual archive.

### Accessing Archive Data

In order for client applications such as DataDirect to access archived historical data, either restore the archived data restored from the archive media to the restored History database, or publish the archive volume. The method used depends on the type of entry.

For property logs and profile logs, the only method is to publish an archive volume to make the archived data available directly from the archive media. Publishing is simpler and more efficient than restoring the archived data. The contents of a complete volume, or even multiple volumes can be published in relatively few steps. Also, this method does not require the archive data to be written to Oracle tables in the restored database. Since Oracle tablespace is limited, the publishing method is used to expose a larger amount of archive data for client applications at any one time.
Publishing an Archive Volume

Archive volumes support viewing of archive data (through the corresponding archive volume aspect). The hard disk media can be partitioned into any number of archive volumes.

Publishing may be performed via either an archive device aspect, or an archive volume aspect. This lesson shows how to use the archive device aspect, Figure 153. Select the volume to be published and choose Publish from the context menu.

Figure 153. Publishing a Volume
Accessing Published Logs

Published logs can be accessed by external applications such as DataDirect as easily as runtime logs. A quick check may also be performed using the Log Configuration aspect. To do this:

1. Open the Archive Volume aspect from the Archive Device aspect. To do this, select the volume and choose Open from the context menu, Figure 154.

![Figure 154. Opening an Archive Volume Aspect from the Archive Device Aspect](image)

Reference Figure 155 for steps 2 and 3.

2. Select an entry from the list of archive entries (upper pane).

3. In the selected entry’s log list (lower pane), select one or more logs whose published data is to be viewed.

4. Select the log list (lower pane) and choose Platform Info from the context menu.

   This displays the Platform Info dialog, Figure 156.
Figure 155. Selecting Logs Whose Published Data You Want to View

5. Select a log from the log list, then double-click the Log Configuration icon in the selected log’s aspect list (lower pane), Figure 156.
This displays the Log Configuration aspect, Figure 157. When an archive volume is published, the Log Configuration aspect will have restored logs (indicated by Rst) in addition to the runtime logs. For the restored logs, use the Archive tab to view archive information including status and last archive time.

6. To view the published archive data, select a log with the _Rst suffix, select the Status tab, then click Read, Figure 158.
Figure 157. Log Configuration Aspect - Archive Tab

Figure 158. Viewing Published Archive Data
Viewing Published Archive Data with DataDirect

**Figure 159** shows how to view published archive data using the History Values dialog in DataDirect.

![Image of the History Values dialog](image)

*Figure 159. Viewing Published Archive Data With DataDirect*
Unpublishing a Volume

The media database files are pre-allocated to a certain size. When there is not enough room in the files to publish another volume, the files will increase in size. Unpublishing a volume makes the file space used by that volume available for other volumes to be published in the future. Therefore, a volume should be unpublished when it is not needed.

To do this:

1. Select the volume.
2. Choose **Unpublish Volume** from the context menu.

![Figure 160. Unpublishing a Volume](image)

Inform IT Authentication

Authentication can be configured for certain operations related to Information Management to help meet FDA 21CFR part 11 requirements. Authentication determines whether or not approval will be required before a user will be allowed to perform a certain function, for example: enabling, executing or modifying a calculation.
Configuring Access Control

Inform IT Authentication may be set to one of these levels:

- None (no authentication required).
- Single Authentication (one digitally signed user is approved by entering user name and password).
- Double Authentication (two digitally signed users are approved by entering user names and passwords).

To configure authentication for a calculation aspect category follow the steps below:

1. Open the Aspect System Structure in the Plant Explorer.
2. Expand the Aspect System Structure and also the Inform IT Calculation Aspect.
3. Select the Calculation, Aspect Category object.
4. Select the Inform IT Authentication aspect in the aspect list.
5. To set Authentication for an Operation:
   a. Select the operation. Click Select All for example.
   b. Mark the Authentication required. Single Authentication for example.
   c. Click Apply.

Checking Access Control

To check authentication:

1. Open the Object Type Structure in the Plant Explorer.
2. Expand the Object Types and also the SoftPoint, SoftPoint Object Types.
3. Select the Counter, SoftPoint, SoftPoint Object Type.
4. Select the Calculation aspect.
5. Click the Save icon. A Save dialog requiring your User ID and Password will display.
6. Enter your administrative user id and password to authorize the save.
As an administrator you have all permissions because the security is turned off. By default, a user does not have all roles. The First Signature and Second Signature permissions can be set up for users in the Aspect Category Definition aspect or at the object level using the Property Override aspect.
Section 6 Batch Integration

The purpose of this section is to create a working 800xA application using Batch Management and follow the flow of information from Batch Management into the Information Manager, out to reports, and off line storage of the Batch Production Data in an archive.

The lessons in this section show you how to:

• **Configure Information Management for Batch.**
  – Add Batch Specific Message Log.
  – Set Up the Batch Report Job.
  – Set Up Batch Archive and aging of the online data.

• **Configure Batch for Information Management.** This covers
  – What is required in a batch recipe to populate the Production Data Log.
  – Passing parameters from the Batch Recipe to the Schedule argument structure and finally as parameters into the report itself.

• **Viewing the Executed Batch Report.**

• **Additional Lessons.**
  – Creating Reports using Typical Queries and Views.
  – Batch Archiving.

It is expected that you have worked through the lessons in the previous sections before using the lessons here.
PDL for Batch Management Overview

The Production Data Log (PDL) and OPC message Log applications support data storage and retrieval for Batch Management. PDL software is an option for the Information Management History Server function. PDLs are History logs that store production data such as batch start/end times, batch variables, and recipe data. PDL supports collection, storage, and retrieval of this production data for presentation in batch reports.

The current architecture of the Batch Management interface to Information Management does not support the recording of the Batch Recipes (PFCs) to more than one Information Management PDL. The PFC is guaranteed to be on one of the Information Management Server nodes. If trying to view a PFC from a PDL on one Information Management Server node results in one not being found, look for the PFC on another Information Management Server node.

The PDL Extractor can only be used for recipes from PDL that have not been restored.

Batch Management can:

- Send batch information to the PDL. Batch automatically sends BatchID and start/end times for different task types: Campaign, batch, unit procedure, operation and phase.
- Send history associations to create time markers for specified numeric and event logs.
- Send variable/tag data to be stored with the batch.
- Send batch procedures to the PDL.

To get other data into a report, it must be planned for in the recipe. The following must be manually added to the Batch Recipe in order for it to show up in PDL.

- Trend associations.
- Batch Variables.
- Phase Variables.

A Series of database tables and views provide easy access to the information using Batch name as the primary key.
Configure Information Management for Batch

Batch data can be sent to and stored in a production data log (PDL) and a batch specific message log on the Information Management server. Information Management can be used for batch to batch analysis, batch reports and batch trending. It does this by providing a hierarchical history of batch data and events and custom organization, storage, archival, and retrieval of batch data and events.

Add Batch Specific Message Log

The **PDLMSGLOG** log type is a special implementation of the **OPC_MESSAGE** log type for storing batch events related to Batch Management.

1. Open the Node Administration Structure / **node name** / IM_Inform IT History_**node name**, Service Provider / Inform IT History Object / Message Logs.
2. Create a new Inform IT Message Log object and Name it **PDLMSGLOG**. When this access name is entered, the IP address for the local History server is automatically appended to the access name.
3. Set the Message Log Type to **OPC_MESSAGE**.
4. Set the Capacity to 1000.
5. Click Apply. When changes are applied, the IP address of the local History server is automatically appended to the PDLMSGLOG object name.
6. Click Mode and set it Active.

Set Up the Batch Report Job

1. Open the Scheduling Structure.
2. Expand Schedules and Jobs and select Batch Report Crystal, Job Description.
3. Select the Action Aspect and click the Edit Parameter List button.
4. Select PlantName, click Modify and change the Value from Plant Name to Getting Started Plant and click OK.

The <BatchID> argument is automatically passed to Crystal Reports and included in the Report Parameters list.

6. To add a time stamp, edit the object patch as follows:

   Completed Reports/Crystal/BatchReport_<BatchID>_<TimeStamp>

   and click **Apply** to the aspect view of Action Aspect.

7. Select the Scheduling Definition aspect.

8. Set the Schedule as Periodic Schedule, leave it disabled, and set the Service Group.

9. Click **Apply**.

**Set Up Batch Archive**

To allow batch archiving, do the following.

1. Open the Node Administration Structure / node name / IM_Inform IT History_node name, Service Provider / Inform IT History Object / Production Data Logs.

2. Open the Inform IT PDL Auto Archive aspect.

3. Set the Archive Device to **ArchDev1** which was created when Adding an Archive Device on page 151.

4. Set the Archive Mode to: **On Batch End**.

5. Set the Archive Delay to: 5 Minutes

6. Set the aging of the online data by setting the following:
   - **Archive Mode** to On Batch End
   - **Delete Mode** to After Archive
   - **Archive Delay** to 15 Minutes
   - **Delete Delay** to 30 Days.

7. Click **Apply**.
Configure Batch for Information Management

This section describes how to create a batch application and populate the Production Data Log as a result of using the following.

- BMA Compute blocks write task variables into PDL.
- BMA Data Collection blocks set start & stop batch trend collection association time values.
- BMA Schedule Job block automatically generates reports and passes parameters to the Scheduler. Execute the report **At End of Batch.** The BMA Schedule Job block can run multiple Jobs.

To continue the example, add the equipment and recipe procedure as described in the following and then run the batch.

Adding Equipment and Variables

Add Batch Equipment aspect to a Generic Object as follows:

1. Open the Functional Structure.
2. Create a New Object (Generic Type) in the Root, Domain and Name it **BatchGenericUnit.**
3. Create a Batch Equipment aspect in the BatchGenericUnit object (listed under Batch Management Equipment).
4. In the Main View, General Tab set the Controller Type to **None (Pseudo).**
5. On the Equipment Attributes tab, click the **Append new unit attribute** button thrice to create three rows.
6. Enter the following into rows 1, 2 and 3:

<table>
<thead>
<tr>
<th>Row</th>
<th>Name</th>
<th>Description</th>
<th>Type</th>
<th>Default</th>
<th>Low</th>
<th>High</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Temp</td>
<td>Unit Temperature</td>
<td>Float</td>
<td>5.5</td>
<td>0.0</td>
<td>212.0</td>
</tr>
<tr>
<td>2</td>
<td>Level</td>
<td>Unit Level</td>
<td>Integer</td>
<td>76</td>
<td>0</td>
<td>100</td>
</tr>
<tr>
<td>3</td>
<td>ExtSignal</td>
<td>SoftPoint</td>
<td>OPC Datapoint</td>
<td>Signal*</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Adding Recipe Procedure**

Add a Recipe Procedure, Figure 162, as follows:

1. Open the Procedure Structure.
2. Create a New Object (**Procedures**) and Name it Batch History Reports.
3. In Batch History Reports, create a New Object (**Recipe Procedure**) and Name it BatchHistReport.
4. Select the **Development Procedure** aspect and select **Edit Procedure** from the toolbar menu selections. This will open the Procedure Configuration tool.

* Signal = Root/SoftPtNetwork/SoftPoints/Counter1/Counter1 Count:Value

7. Click the **Save** button. The completed aspect is shown in Figure 161.
5. Select **Tools > Procedure parameters** and enter the following:

Parameter 1: Equipment
Type: Equipment List
Default Value: BatchGenericUnit(Root)
Constraint: BatchGenericUnit (from the Configure Equipment List)

Parameter 2: Yield
Type: Float
Description: red dye
Default Value: 30.0
Low Range: 0.0
High Range: 30000.0
Eng. Units: Gallons

6. Create and connect the following objects, **Figure 162**, as described below. Delete the default connection between Start and End.
Create and Connect Acquire Unit (Acquire Equipment)

a. Place a BMA object below Start.
b. Select **Edit > Block Properties** (or select the BMA object using the middle mouse button).
c. Select **Acquire Equipment** and click **Next**.
d. Enter the Block Label as Acquire Unit.
e. Select Equipment parameter and add it (>) to the Selected Equipment list.
f. Click **OK**.
g. Connect Start to Acquire Unit.
Create and Connect Start History (Batch Data Collection)

a. Place a BMA object below Acquire Unit.
b. Select **Edit > Block Properties** (or select the BMA object using the middle mouse button).
c. Select **Data Collection** and click **Next**.
d. Enter the Block Label as Start History.
e. Select the **Append data collection** icon to add a row.
f. Enter the Logical Name as: “Tag1”
g. Select a unique OPC Item (...) and browse in the Control Structure to SoftPoints, Counter1 Count and select Value as the OPC Point.
h. Click **OK**.
i. Leave the Data Collection Rate as: Start.
Start will flag the time the block was executed as the start time of the History Association.
j. Click **OK**.
k. Connect Acquire Unit to Start History.

Create and Connect Restart Time (Compute)

a. Place a BMA object below Start History.
b. Select **Edit > Block Properties** (or select the BMA object using the middle mouse button).
c. Select **Compute** and click **Next**.
d. Enter Restart Time as the Block Label.
e. Select the **Append expression** icon twice to add two rows.
f. Enter these expressions:
   Row 1: bdbput("restartTime",time()+60)
   Row 2: bdbput("timeCheck.in",time())
g. Click **OK**.
h. Connect Start History to Restart Time.

**Create and Connect Delay (Transition)**

a. Place a Transition object below Restart Time.

b. Select **Edit > Block Properties** (or select the BMA object using the middle mouse button).

c. Select **Transition** and click **Next**.

d. Enter the Block Label as Delay.

e. Enter this Transition:
   ```
   time()>=dbget("restartTime")
   ```

f. Click **OK**.

g. Connect Restart Time to Delay.

**Create and Connect Release Unit (Release Equipment)**

a. Place a BMA object below delay.

b. Select **Edit > Block Properties** (or select the BMA object using the middle mouse button).

c. Select **Release Equipment** and click **Next**.

d. Enter the Block Label as Release Unit.

e. Select Equipment parameter and add it (>) to the Selected Equipment list.

f. Click **OK**.

g. Connect Delay to Release Unit.

**Create and Connect Batch Report (Schedule Job)**

a. Place a BMA object below Release Unit.

b. Select **Edit > Block Properties** (or select the BMA object using the middle mouse button).
c. Select **Schedule Job** and click **Next**.
d. Enter the Block Label as Batch Report.
e. Expand **Schedules and Jobs**, select Batch Report Crystal and add (>) it to the Scheduled Jobs list.
f. Change the Scheduled At to: **At batch end**.
g. Click **OK**.
h. Connect Release Unit to Batch Report.

**Create and Connect End Time (Compute Block)**

a. Place a BMA object below Batch Report.
b. Select **Edit > Block Properties** (or select the BMA object using the middle mouse button).
c. Select **Compute Block** and click **Next**.
d. Enter the Block Label as End Time.
e. Select the **Append data collection** icon to add a row.
f. Enter the expression:
   
   ```
   Row 1: bdbput("timeCheck.out", time())
   ```
g. Click **OK**.
h. Connect Batch Report to End Time.
i. Connect End Time to End.

7. Select **File > Save** and the **File > Exit**.
8. Select Development Procedure, and then select **Approve Procedure** from the context menu. Select a reason (Approve) and click **OK**.

This sets up the basic Batch Recipe Procedure.

**Run the Batch From the Batch Overview**

Running the batch automatically passes all necessary values that need to be mapped into the standard Batch Crystal Report.
1. Open the Library Structure.
2. Open Batch Management > Batch Management, Batch AE and select the **Batch Overview** aspect.
3. Click **Add**.
4. Use Procedure to drill down and select **BatchHistReport**.
5. Set Batch ID to **Auto**.
6. Set Scheduled Status to Scheduled.
7. Click **Apply**.

**Verify Output using PDL Browser**

The PDL Browser can be used to verify what data was output as follows.

1. Open the PDL Browser.
2. Select the **Task Type** of Batch.
3. Click the **Search** button.
4. From the Search Results, select the Batch that just ran.
5. Select the tabs (Variables, Resources, Messages, etc.) to view the output.

**Viewing the Executed Batch Report**

After running the Batch Recipe Procedure, view the report as follows.

1. Open the Scheduling Structure.
2. Expand Reports and then the Completed Reports folder.
3. In Crystal, select the executed report.
4. Select the File Viewer aspect to view the report.

As an alternative, to run a report manually:

1. In the Scheduling Definition aspect for the report, use the Arguments tab and enter the batchID to the name of the Batch that just ran or an earlier one.
2. On the Schedule tab, click **Run Now**. The job will show in the Running Jobs list and then will be put into Reports / Completed Reports / Crystal.


### Additional Lessons

To help you understand the relationships between Batch, Information Management and Reporting refer to the following topics:

- **Views for Batch Management** on page 185
- **Creating Reports using Typical Queries and Views.** on page 185
- **Batch Archiving** on page 186

### Views for Batch Management

There are 12 views designed specifically for Batch Management applications:

- Batch_Header.
- Batch_Equipment.
- Batch_Vars_MatchedPair.
- Batch_Variables.
- Batch_Procedures.
- Batch_ProcessEvents.
- Batch_AuditEvents.
- Batch_CommentEvents.
- Batch_Events.
- Batch_BatchMgrEvents.
- Batch_SystemEvents.
- Batch_Trend.

### Creating Reports using Typical Queries and Views.

Refer to *System 800xA Information Management Data Access and Reports (3BUF001094*) for detailed information on **Creating a Report with Crystal Reports** in Section 5, Creating Reports. The tutorial shows how to build a report for historical process data related to a batch. The Batch ID is dynamically updated for each report. The 800xA Batch Management application writes the batch ID into an
argument value which is then passed into the report as a parameter. Refer to the reports provided within the 800xA system for additional information. For Crystal reports, examine the Master_Batch report. This report contains subreports for each of the database views including charting of numeric data.

Reports can be started automatically upon batch completion using the scheduler. Parameter values are passed from Batch Management to the scheduler. The report parameters are passed into the report. The Batch Identifier parameter (one of the key parameters for the views referenced in the previous paragraphs) is one of the parameters passed into the report.

## Batch Archiving

Archiving batch data has no effect on the uniqueness of the batch ID. Even after data associated with a batch ID has been removed from the system, a record of the batch ID will be retained on the system. The batch ID can never be reused.

Automatic archiving of batch data is established as an overall archive policy in the 800xA Node Structure for the archive service. The archive policy provides the ability to archive data based on batches and retain the data online for a period of time after the data has been archived to safe offline storage. It is important to establish an archive policy to ensure that data is managed and preserved to offline storage as well as ensure proper performance of the system.

## Verify that Batch Archive Completed

Open the Archive Volume aspect. The information provided on this aspect is organized in three parts. The top section provides information for the selected volume. The middle section lists the entries currently stored on this volume. When an entry is selected in the middle section, the logs that were archived for the selected entry are shown in the bottom section.

## Manual Archiving

Manual archival is performed via the View Production Data Logs aspect.

1. Select the Node Administration structure in the Plant Explorer.
2. Select the History service provider for the node where the logs to be archived are located (IM_InformIT History_YourNode, Service Provider).

3. From the History service provider, navigate to and select the Production Data Logs group under InformIT History Object.

4. Then select the Inform IT History View PDL aspect from the aspect list.

5. The log class for manual archival is Run Time. Use the Log Type pull-down list on the Retrieve tab to select the Run Time option.

6. Click Apply. This will display all PDLs for the selected log type.

7. Select one PDL from the list to retrieve its corresponding tasks.

   The tasks are displayed in the lower pane beneath the log list. The Filter Tasks tab is used to apply a filter to reduce the retrieved Task list.

8. To archive the entire PDL, click the Archive PDLs tab.

9. Specify the Archive Device (name of the archive device where the logs will be copied) and Surface (surfaces corresponding to the selected archive device). Optionally, enter a description.

10. Click Archive when finished.

    To archive selected tasks, click the Archive Tasks tab. This tab is identical to the Archive PDLs tab, except that the Archive button is not active until tasks have been selected from the Task list. Select the tasks from the Task list, fill in the information, then click Archive.

---

**Looping Recipe Limitations**

Information Manager does not support looping recipes that loop more than 999 times. If a looping recipe is created that is approaching or exceeds 999 iterations the
Operator/User will be notified as detailed below. An example of a looping recipe is shown in Figure 163.

![Diagram of Looping Recipe](image)

*Figure 163. An example of a Looping Recipe*

**User Message Formats**

1. Once the recipe reaches 900 iterations the following message is displayed in the event list on every 10th additional iteration. (Here x can be 910, 920, ..., 990)

   "<Batch Campaign/Job name> with loop config for <Batch Procedure/phases> will have PDL Overwritten for 999th Occurrence; It
has reached <x> iterations against 999 being max. Please Reconfigure Batch.

Here x can be (910/920/.990)

2. Once the recipe exceeds 999 iterations the PDL data will still be saved as part of 999th iteration even though the occurrence number is incorrect. Data will continue to be stored until the the batch exceeds 1500 iterations. The following message is displayed in the event list when this situation occurs.

"PDL is Overwritten at 999th Occurrence for <Batch Campaign/Job name> with loop config in <Batch Procedure/phases>. <x> being Occurrence; PDL will be lost after 1500 iterations. Please Reconfigure Batch."

3. For recipes that exceed 1500 iterations the following message will be displayed in the Event List.

"PDL Data is lost for <Batch Campaign/Job name> with loop config in <Batch Procedure/phases>. Current Iteration is <x> against 1500 being max for 'Overwrite'. Please Reconfigure Batch."
Revision History

Introduction

This section provides information on the revision history of this User Manual.

The revision index of this User Manual is not related to the 800xA 6.0 System Revision.

Revision History

The following table lists the revision history of this User Manual.

<table>
<thead>
<tr>
<th>Revision Index</th>
<th>Description</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>-</td>
<td>First version published for 800xA 6.0</td>
<td>August 2014</td>
</tr>
<tr>
<td>A</td>
<td>Updated for 800xA 6.0.1</td>
<td>October 2015</td>
</tr>
</tbody>
</table>

Updates in Revision Index A

The following table shows the updates made in this User Manual for System 800xA 6.0.1:

<table>
<thead>
<tr>
<th>Updated Section/Sub-section</th>
<th>Description of Update</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Sections</td>
<td>New interface Datadirect Screen shots have been updated.</td>
</tr>
</tbody>
</table>
Updates in Revision Index A
archive 150  
  group 155, 158  
archived logs access 163  
Authentication 170  

bring on line 47  

calculation aspect  
  view 37  
cyclic schedule 39  

data  
  archive 151  

export report output 101, 136  

hysteresis 33  

limiters 32  
  log  
    numeric 50  

ODA server 112  

report log 139  

restored log access 163  

softpoint object  
  instantiate 42